NEW FEATURES
PHOTOSHOP CS6.1

LIGHTROOM 4
NEW FEATURES

DREAMWEAVER CS6
RESPONSIVE DESIGN

INTRODUCING
SPEEDGRADE

NEW FEATURES
CAMERA RAW 7
ILLUSTRATOR CS6
INDESIGN CS6
AFTER EFFECTS CS6
PREMIERE PRO CS6

WHAT IS
CREATIVE CLOUD?

PHOTOSHOP
3D CITY TUTORIAL
Adobe Creative Cloud . Colin Smith
Photoshop CS6 New Features ... Colin Smith
New in Camera Raw 7... Jack Davis
New for Tablet Users in Photoshop ... Weston Maggio
Photoshop CS6 3D... Stephen Burns
3D City Tutorial... Kirk Nelson
Illustrator CS6 New Features ... Chana Messer
Dreamweaver CS6 New Features... Janine Warner
Lightroom 4 New Features... Colin Smith
Indesign CS6 New Features ... David Blatner et all.
After Effects CS6 New Features... Jeff Foster
Speed Grade CS6, Introducing Speedgrade... Colin Smith (2)
Premiere CS6 New Features... Colin Smith
Welcome to the Creative Studio CS6 Superguide. Here you will find a wealth of information on Adobe's latest release.

I'm very excited to have gathered a superstar team of writers for this our third Superguide. Expect a Superguide from us each time Adobe has a major release of a new Creative Suite. Count this as part of your exploration process.

Check out our coverage of Photoshop CS6, Camera Raw 7, Illustrator, Lightroom, InDesign, Dreamweaver, After Effects, Premiere and more. Why Lightroom? Because Adobe has launched a new way of getting your software. This is the Creative Cloud, it includes all of Adobe's creative applications for one monthly subscription. You download the programs and run them from your computer just like before. This superguide gives you insight to what each application is for and what it does.

If you aren't a subscriber on our mailing list, make sure you join up so you don't miss any of the exclusive tips and discounts only on our mailing list. (If you signed up for this superguide you're already a member, it's free!)

Also check out the free videos on Photoshop CS6. A lot of this content has been compiled into a companion CS6 microsite at www.PhotoshopCAFE.com/cs6. There are also some videos and other goodies there.

Also if you're looking for more in depth training, we have 35 of the world's best trainers delivering over 80 different courses to help you on your learning adventure. You can find all of that at PhotoshopCAFE.com/video.

I hope you enjoy this superguide and you find it useful. If so, tell your friends about it.

Your partner in success,

Colin Smith
Publisher

Welcome to this CS6 Superguide

CONTRIBUTORS

Jack Davis has authored 19 books. He is an entrepreneur of a dozen different creative titles including the bestselling (a million copies+ in 12 languages) guide to Photoshop, The Photoshop Wow! Book, and How to Wow: Photoshop for Photography. Davis is part of the “Dream Team” at the Photoshop World Conferences and was one of the first inductees into the Photoshop Hall of Fame for his lifetime contributions to the industry. For more about Jack, his training material and teaching schedule go to WowCreatives.com.

Janine Warner’s best-selling books and videos about the Internet have won her an international following and earned her speaking and consulting engagements around the world. She is the creator of DigitalFamily.com, and runs a full-service interactive agency that offers web design services, iPad App development, content strategy, and internet marketing. She is a member of the TV Academy’s Interactive Media Peer Group and has served as a judge in the Interactive Emmy Awards, the Knight News Challenge, and the Aruba de Oro Latin American Internet Awards.

Colin Smith is the founder of PhotoshopCAFE which has received over 30 million visitors. Colin has authored 19 books. He has won numerous awards including 3 Guru awards. He’s been nominated for the Photoshop Hall of Fame twice. Colin is a regular columnist for Photoshop User Magazine. He’s been featured in almost every major imaging magazine, and is in high demand as a speaker at major industry events including WPPI, SignGraph, PMA and Flash Forward. He consults such companies as ABC Disney, Apple and Adobe.

Colin Smith (2) has been swimming in the deep end of the video and imaging industries for over 20+ years. 15 of those years have been spent at Adobe Systems where he continues to evangelize leading edge solutions to customers all over North America including Hollywood filmmakers, New York media giants and broadcast and animation houses in Canada. Colin’s passions and accessible speaking style makes him a major draw at a multitude of Adobe events and seminars as well as making regular appearances on his hit show “No Stupid Questions” on Adobe TV.

Stephen Burns has discovered the same passion for the digital medium as he has for photography as an art form. His background began as a photographer 28 year ago, and in time, progressed toward the digital medium. Stephen Burns has been a corporate instructor and lecturer in the application of digital art and design for the past 12 years. He has been exhibiting digital fine art internationally at galleries such as Durban Art Museum in South Africa, Citizens Gallery in Yokohama, Japan, and CECUT Museum Of Mexico to name a few.

Chana Messer has been swimming in the deep end of the video and imaging industries for over 20+ years. 15 of those years have been spent at Adobe Systems where he continues to evangelize leading edge solutions to customers all over North America including Hollywood filmmakers, New York media giants and broadcast and animation houses in Canada. Colin’s passions and accessible speaking style makes him a major draw at a multitude of Adobe events and seminars as well as making regular appearances on his hit show “No Stupid Questions” on Adobe TV.

Chana Messer is a Fine Artist, Designer, Trainer and Software Evangelist Teaching at the university level for 25+ years in the fields of Fine Art, Digital Imaging in the Departments of Visual Arts at UCLA. Lead Instructor at the Walt Disney Company. Chana is an Adobe Certified Expert, Adobe Partner, Adobe Community Professional, part of the Adobe Professional Freelance Team, and an Adobe User Group Manager. As such she has been invited to present at Adobe events at NAB World and NAB, Adobe MAX and other events in Los Angeles, San Francisco, Portland, Chicago, New York and Tel Aviv. Chana is an exhibiting artist you can see her work at: www.chanamesser.com

Jeff Foster is a published author of several computer technology, animation and video production VFX books and videos. He has been an Adobe Certified Expert and has served as an instructor and featured speaker at conferences such as Photoshop World, Macworld, Adobe MAX and the NAB (National Association of Broadcasters) Conferences. Some of his clients include: Tribune Broadcasting, Matanale, McChannel Douglas, Netlix, FOX Television, Spike TV, Discovery/TLC, Deluxe Digital, Universal Studios, Lions Gate Films and Disney. You can learn more on his blog at http://PixelPainter.com. Check out his training on Photoshop CAFE.

Wes Maggio is a long-time tablet user and Senior Solutions Manager at Wacom Technology Services Corp. He is a passionate trainer and speaker, presenting at various photography and design events around the world. He is also a contributing writer to numerous creative magazines and he is the coauthor of the leading title on tablet training; Wacom Tablets and Photoshop CS6 from PhotoshopCAFE.

David Blatner and Anne-Marie Concepcion are regarded as the top InDesign experts and have authored a ton of book and spoken at many events. Together they run the top InDesign Resource and magazine InDesignSecrets.com

Kirk Nelson is an Adobe Certified Expert, Freelance Author, Trainer, Speaker, Friendly Neighborhood Graphics Geek. www.thepixelpro.com
What is Creative Cloud? In a nutshell, Adobe has made it possible to have access to all their creative products, for one monthly fee. You subscribe and download your apps all online, in the “cloud”.

While Adobe has released the Creative Cloud, the option to buy individual products or Suites remains the same. You can still order a boxed copy from Adobe or resellers, you can still buy a download if you prefer. There is still upgrade pricing available etc. Just like always. So if you are a person who prefers to own, or only have the need for a single product, this might be the best way for you to go.

For those who decide on the Creative Cloud, this is what it looks like.

There are two main areas that will interest you. One is files. This is where you can keep your images and files on the cloud (Adobe’s servers). You have 20 GB to play with.

THE APPS, WHAT YOU GET

The part that you will care about the most right now is the Apps tab. Here is where access is granted to all the Adobe Apps from the Creative Suite Master collection as well as Lightroom. They Don’t RUN from the cloud, the license server does. When you run programs (apps), they check with the Creative Cloud to make sure your subscription is active. As long as it’s active, you can run all the programs. The cloud apps will run on 2 machines, just like the Current Adobe apps. The difference is, you can run one on Mac and one on Windows if you prefer.

The apps need to be downloaded to your local computer and they install just like they always have. This is how it works, first of all the Adobe Application Manager is downloaded. The app manager runs on your desktop and lists all the available apps. Simply click install to download and install. You can choose several products at a time and they will download and
install one at a time. Installation is painless and runs in the background. I selected all the apps and went out for dinner. When I returned, they were all installed. The process was painless for me. Apps are launched from your dock or desktop, just like any other app.

EXTRAS
You also have access to Business Catalyst, which is a no-program website you can set up for yourself either through Dreamweaver or Muse. You can have up to 5 feature rich sites with a subscription (This used to be called Goodbarry, before an Adobe acquisition). You also have access to typekit, a service which serves up web fonts, for adding something more interesting to your website than arial.

The latest addition, which is a real head-turner, is Adobe Single Editions. This enables you to create a Digital Publication through DPS (Digital Publishing Suite) built into Indesign. Single Edition allows you to create an app and submit it to the iTunes store. It used to cost a lot of money to create a digital edition, but Single Edition, allows you to crate apps, all included in the monthly subscription price.

UP TO DATE
One of the big benefits of the cloud is update cycle. It used to be, that you would have to wait 18-24 months for a new feature to be included in your software. Now Adobe, is able to push new features out to the cloud and they are only available for subscribers. For everyone else, there will still be major new versions released, but they will have to wait for the features in the next version. Just like it's always been. So subscribers are alloed a fast track so to speak.

There have already been some updates to most of the apps including one to photoshop, called CS6.1. I discuss the new features in the next section, where I address all the CS6 new features of Photoshop.

CLOUD FOR TEAMS
A recent announcement from Adobe is the Creative Cloud for Teams. This provides more space per user. It also provides for a larger number of installs (seats). The account manager can move the seats around and assign them to different employees. This is a good option for a larger company with revolving staff and changing needs.

TO CLOUD OR NOT TO CLOUD?
So, I guess you will be looking for a recommendation from me?

Adobe’ pricing on Creative Cloud is $49.99 per month. This includes all the Creative Suite Apps as well as 20 Gb hosting, and storage. Create Suite CS3,4 and 5 users can get the Creative Cloud for $29.99 per month for the first year. Note: Adobe just extended the offer, so it could go on longer.

Making the decision to dump the box in favor of the cloud is not a cut and dry answer. For me, it represents great value because I use almost all the apps in the suite on both Mac and Windows, so it makes a lot of sense. For those who don’t already own the latest version of the Suite, it’s a great way to get into all the Adobe products for essentially $50 a month. That’s $600 a year. (Or about a dollar a day, $360 while the introductory special is in place).

If you already own a current suite, look at the upgrade price and then compare it to 18 months-2 years between upgrades at $600 a year and see what makes sense to you. Also bear in mind,if you are a current Creative Suite owner, once you commit to the cloud, it might be a permament decision, you could forfit your upgrade pricing should you decide to go back to the boxed product for CS7. Also decide if you need Business Catalyst, typekit, Single Edition, access to new Features and the 20 Gb cloud storage.

My advice is simple, look at your needs, do the math and make your decision accordingly. Don’t make your decision based on the $29.99 introductory offer, because you are in this for the long haul. I would say for most people the Cloud makes sense and is a good deal. If you are only using a couple of Apps such as Photoshop and Lightroom, then you might be better off sticking to the regular upgrades, unless you have a thirst for new features right away and you have the urge to explore other Adobe applications.
It’s been 2 years since Photoshop CS5 started shipping. Remember that beta means that all production work should still be done in Photoshop CS5. Kick the tires and enjoy the new features of CS6.

USER INTERFACE
The first thing you will notice when you first open Photoshop CS6, is the new look. There is a new dark User Interface. It’s a bit of a culture shock at first, but once you get used to it, it’s really great. There are four different flavors of it and you can change them all in the preferences menu. Yes, the old familiar light interface is one of the options. I suggest giving the dark ones a go though, you might just love them. You can also press the Shift+F1 orF2 keys to cycle through the new colors.

Another thing, you might not notice at first is that the look and feel of the panels have been tightened up and now more consistent naming is used throughout.

PROPERTIES PANEL
If you are used to looking at the Masks Panel, the Adjustment controls for Adjustment layers and the 3D options, they have all been consolidated into a Properties panel. This helps reduce clutter.

When you go into the filters menu, you might think a lot of filters are gone. Actually it’s just the clutter that’s gone, all the missing filters are tucked away under the Filter Gallery. Definitely worth mentioning is Preferences can now be imported and exported. This is great for people with lots of custom brushes, shapes, actions etc. I know, I have several computers and it’s difficult to move them all over manually, and I always lose a few when I upgrade to a new version of Photoshop. Photoshop CS6 offers the option to migrate old presets over on launch; I have to say that I love it!
The third in the gallery is the field blur. This is a quick way to simulate depth of field. You can set two points at different amounts of blur. A smooth blend of blur will be created between the two points. You are supposed to set one point blurry and the other one sharp and move them around to create a smooth blend. Of course there is nothing stopping you from adding blurs to both and going for a creative style effect.

All of the blurs also have the option to set a Bokeh style highlight, which is either a specular white or a saturated color.

**ADAPTIVE WIDE ANGLE**

An interesting addition to the warp-style effects. This line is designed to straighten out barreled images and in particular panoramas. If you have ever stitched any panos together, I’m sure you have noticed that they can get really distorted and wavy. Using the adaptive wide angle, drag out a line and Photoshop straightens the photo to make the line level. Apply several lines to a panorama and you can either straighten in completely, or turn it into a mess. (This one take a little practice to master, but is super useful when you have it tamed).

**CROP**

The Crop tool is nothing short of amazing. It’s all GPU accelerated, which means that everything happen on-screen and it’s fast! You can view the crop overlays and position your image within the crop bounds and even rotate it right on screen. You have to see this realize just how cool it is.
**PERSPECTIVE CROP TOOL**

In addition to the crop tool, there is a perspective crop tool. Position this over an image and pull each corner out at different angles. This makes it possible to crop a crooked, perspective, photograph, and make it perfectly straight in just a few seconds. Truly amazing and super useful!

**CONTENT AWARE**

The content aware magic continues. I’m sure you remember Content Aware Scale in CS4 and Content Aware Fill in CS5. Now Photoshop CS6 Beta has a new tool called Content Aware Move. This is a great tool for a couple of things. If you want to take a small element from an image and reposition it, this tool does a great job. However if you want to get a bit more creative, you can stretch and reshape objects with the tool. The key is in using the correct option in the option bar. With the Content Aware Move tool selected (under the Spot Healing Brush). Choose either the Move or the Extend option from the Options bar. You will also notice some options in the adaption menu in the options bar, choose strict or loose depending on the result you want, strict and very strict won’t alter the image as much as loose or very loose.

Also noteworthy is the patch tool now has a content aware option. Very nice for filling in larger areas and having more control over the fill content. Simply choose the path, switch it to Content Aware and then move it over a nice “clean” area. The texture from the new area will seamlessly blend into the patch area. I personally love this one!

**LIGHTING EFFECTS**

Lighting effects is back! It was missing in 64-bit versions of CS5 because it was just that, only in 32-bit. It’s been completely rebuilt and works directly on screen now, and not just in a tiny floating panel. The good news is that it now works in 16-bit per Channel Mode. This is great for adding different types of lighting effects to images. Sadly 16-bit mode doesn’t do much for illustration in Alpha channels (Anyone familiar with my Photoshop illustration workflow will know what I mean). When you apply the effect to an alpha channel, the banding is really bad. I’m disappointed because I was hoping to up the ante with my illustrations. Better off to keep using it in 8-bit mode for illustration. Anyone who isn’t creating 3D style effects with Lighting effects and channels will love the new filter though because it’s speedy and easy to use.

**LIQUIFY**

Liquify has had a real nitro boost this time around. It’s all GPU boosted too. This means that the performance is fast. I found it to be amazingly fast. Liquefying is smooth and fluid. When you push the tools, the image moves with you, unlike in the past where there
Photoshop CS6

was a lag and then a sluggish movement of pixels. This performance provides a lot more control over the warping. Also brush size keyboard shortcuts are added, the familiar [ & ] keys that we use for regular brush size, now control Liquify brushes. As an added bonus, the maximum brush size is greatly increased to match today’s larger document sizes.

**WARP TRANSFORM**

This has also gotten a major speed boost. These isn’t any new functionality, just speed, which is always a good thing.

**PUPPET WARP**

The puppet warp now works directly on screen. You don’t have to work in a dialog box; this is great because it’s a distraction to be suddenly taken to a dialog box. It’s also more accurate and faster, all of this thanks to advances in GPU.

**COLOR RANGE**

Worth mentioning, the color range Select>Color Range, now has a face detection, in other words, it now selected skin tones along with it’s other options.

**PAINTING**

Nice new additions to speed performance are the new erodible tips for brushes. These create some nice realistic looking strokes and can also be wrangled for some nice grunge effects. Airbrushes also get some new tips that respond well to tilt with a Wacom pen. I can see a lot of potential with these.

There is also an Oil painter filter that came over from Pixel Bender. This allows you to paint over a photograph and produce some surprisingly realistic oil painting looks.

Small thing, maximum brush size has now been increased to 5,000 pixels. This is good for an overlay of a Photo (without hard edges) from something like a Canon 5D.

**JDI BRUSHES**

One thing I always found frustrating is when you are trying to sample a color and there are adjustment layers on it. You sample the color and begin painting and it’s wrong because it had the adjustments added to the sample. You now have the option to sample a color and ignore the adjustment layers. On top of that you can also sample, current layer, all layers and new is current layer and beneath. (Also current and beneath, no adjustments).

**LAYERS PANEL**

When you first see the Layers panel, it’s obvious that something has changed. Not so obvious at first glance though, is how much.

Layer filtering has been added. For someone who can work with hundreds of layers, this is so awesome!
You can filter by kind (default). These options include images, adjustments, text, vector layers and smart objects. There are also other categories such as name, effect, mode, attribute and color. There is a long list of attributes that include visible, advanced blending and more. Text is interesting because you can search by layer name. I know a lot of people don’t name their layers, but most pros that use a lot of layers always name at least certain key layers. Now if you are a photographer or painter and only use half a dozen or so layers, this isn’t a big deal. If you are an illustrator, designer or compositor, filtering will save you a ton of time. Speaking of layer names, when renaming layers, press the tab key to advance to the next layer and fill out its name too.

NEW VECTOR LAYERS

Designers are going to be thrilled about this one. Vector layers are redesigned. You can now define a stroke and a fill for any vector layers including the pen tool and shape layers. The fills can be solid, patterns or gradients. The strokes can be solid, patterns or gradients too. Check this out, yes; there are now dotted and dashed strokes available!

OTHER THINGS WITH LAYERS

You can now collapse or expand all the layer groups by holding down the Cmd/Ctrl and click the disclosure triangle. You can show/Hide all Layer style details by holding down Alt/Option and clicking the arrows.

You can apply a layer style and flatten the layer in a single click. Also, Layer Styles render in the correct order with shadows on the bottom.

Gradient Layer Styles now include a dither option; this is nice and helps to prevent banding.

You can now do batch tasks to multiple layers at once. For example, applying Layer Styles, Color Labels and locking Layers. There is now an indicator to let you know if advanced blending options are used (Blend if), double click the icon to open the blending dialog box.

TYPOGRAPHY

There have been a lot of significant changes with type in Photoshop CS6 beta.

The biggest thing is type styles. You can create and use both character and paragraph based type styles. This has been a long time coming, as the typography tools have gotten better in Photoshop, it’s always been a pain to have to duplicate styles all the time. Sure there are some neat tricks and workarounds, but you no longer need those, full-blown type styles are here.

Define your font, color, size and more. You can now apply those saved styles to both individual text blocks and also to paragraph text.

Photoshop CS6 now supports custom ligatures, so you can add those nice pairing of characters as well as different alternative characters, when the font supports them.

Another cool addition is Lorem Ipsum. You can now fill paragraphs with placeholder text, so that you can mock up and see what a layout would look like without having to fill with actual text. This is nice, because you no longer have to cut and paste placeholder text from elsewhere.

Smaller things with type include better type rendering, snap to pixels, so you don’t have a soft edge because it’s half way on a pixel as well as new dictionaries.

SCRIPTED PATTERNS

You can get some really cool patterns using the scripted fills. Select a pattern fill, like you would for any texture fill. The difference is, you can choose a scripted fill to lay out the tiles in different ways rather than just the standard tiling. You can do bricks, weaves, spirals and more. If you know some scripting, you can even design some of your own.

ACR 7

With the recent release of Lightroom 4, there was a slightly broken workflow between Lightroom and Photoshop. That missing link was ACR (Adobe Camera Raw). All the settings are now nicely synchronized with
Lightroom 4, so that round trip editing is now a possibility again. For those of you who don’t use Lightroom, here are the main changes to ACR develop module.

**VIDEO**

With the widespread adoption of video on DSLR cameras and even iPhone style devices, everyone is shooting video now.

Adobe reworked the video features. You will notice that the timeline has a new look. Window>Timeline.

Bring video in as a video layer and Photoshop treats it much like the other layers. The big difference is that the video layers contain multiple frames of video. When you reorder the layers in the Layers panel, their order will also change in the timeline. In time speak, the layers start at the bottom and work their way up the panel, with the last clip being the top-most. If you prefer different video tracks, this can be accomplished by creating a new layer group. Each group has its own video track. The timeline will also auto adjust to accommodate longer video as it’s added.

Now, this isn’t as powerful or as fast as Premiere Pro, but it’s powerful enough for you to edit some video. It’s easy to cut the track and set in and out points, by dragging the beginning or ends (Heads and tails) of

**SHADOW HIGHLIGHT**

There is a new RAW processing engine called PV 2012 (Process Version). The main change is dropping of the Brightness, Recovery and Fill Light sliders.

The sliders have largely been replaced with Shadow, Highlight, Whites and Blacks. These are more consistent with what we are used to working with in Photoshop. Shadow Highlight replaces Recovery and fill light with some changes to try and eliminate halos in images that are heavenly processed. The Whites and Black set the white and black points in the histogram, much like what you would expect from the white and black slider in Photoshop levels. Having used these for a while, I’m a big fan of the new Process Version.

But wait. It gets really cool about here. More options have been added to local corrections (Adjustment Brush and Graduated Filter) these include White Balance, moire, noise, shadows and Highlights. Wait, did I just say Moire? There is now a moire reduction filter, which works really well. Having used the Sony NEX and Lumix GF series of Micro 4/3 cameras, I have noticed moire patterns sneaking into some photographs. While this dithering effect might be a nice novelty for a second, I have a feeling the moire reduction will be a popular feature.
clips. You can even add transitions between different clips. Transitions are added by dropping a transition point on the clip. You can change the type and length of the transition at any time.

Where it gets really good is adding effects. You can apply all the same smart filters to video as you would to images, so you can really knock out some professional looks. Speaking of looks you can apply common Color Look Up Table presets to get professional video looks of your video, this is named LUT presets. Don’t forget you can still animate text, shapes and images over the top of your videos to create some cool lower thirds and call outs, title screens etc. Photoshop has supported different video pixel aspect ratios for years. I’m sure a lot of people will have a ton of fun with the video features and I suspect a few will hunger for more and migrate their way over to Premiere Pro or Production Premium.

As for output, you can output either video or image sequences. For more on video, check out my new book: Video in Photoshop for Photographers and Designers (Peachpit Press).

**SMALLER CHANGES**

Rich Cursor support: The cursor displays information like coordinates, image size etc., During many of the functions, such as moving scaling, cropping and more.

Many of you will be happy to know that the Contact Sheet II plug-in and the PDF Presentation are both back in Photoshop. I guess people weren’t too thrilled about their move to Bridge. They are much more convenient right in Photoshop.

While we are on the cool little things. Many people will be glad to hear that Photoshop now has an auto save and auto recover feature. When PS crashes (oops I mean when someone trips a power overload), it attempts to recover the previous image at the point of the last save. Now that will be a lifesaver and I wish I’d had it back in the day when I was working in a building with flaky power that would suddenly cut off.

Mini Bridge now has a Filmstrip mode. This is great for snapping to the bottom of the screen.

Auto correction in levels and in curves is more intelligent now and people should get better results from it. We now have support for 10 bit monitors. Oh, I want to get me one of those!

When resizing layers using the ole’ faithful Ctrl/Cmd-t free transform, you now have the option to choose different bicubic interpolation modes. Choose bicubic sharper if you are scaling down and bicubic softer if you are scaling up.

**3D**

A lot of new stuff has happened around 3D. Repossue has been removed and everything now works on screen. You can create geometry from paths, text and shapes.
Photoshop CS6

Photoshop Cafe.com

"Video in Photoshop for Photographers and Designers"). I can only imagine the kinds of things people will come up with liquify!

CONDITIONAL ACTIONS

Another new feature of interest is the addition of conditional actions. These work like the old actions, but you can create different scenarios or conditions. If the condition is met, Photoshop runs a certain action. If it isn’t, then Photoshop can run a different action.

A crude explanation: “if this is a fact, then do “this” “or else” do this. For example, if the image is horizontal, stick a watermark here, or else if it’s vertical, put the watermark here instead”.

When you are recording actions, you can choose “insert condition” from the Actions Panel options.

MORE CHANGES

There was a lot of confusion with the new crop tool I saw this first hand on the road while doing my Route CS6 tour. Because Adobe removed the resolution box from the toolbar, it really threw a lot of people. The resolution has now been added back.

If you have used the new Type Styles, they are a huge time-saver. The problem is that they are only

New, New Features
PHOTOSHOP CS6.1 CREATIVE CLOUD UPDATE

The very first Creative Cloud update to Photoshop opens up some new features and functionality. The first thing is retina support dubbed HiDPI (Which is a strange name, since DPI is dots per inch, which is a print term). However, I must say on a Retina Macbook Pro, the display is beautiful. It might be a little frustrating for web designers since everything is now 1/2 size on a supported retina display because the pixels are much denser. This update is available to all Photoshop CS6 owners and is is a free update.

SMART OBJECT FEATURES

Let’s touch on the new features available for Cloud Subscribers. First of all; Smart Object support for the Blur Gallery and Liquify. These effects can now be applied non-destructively to a Smart Object. A huge advantage of this, is that they can now be applied to video. (I actually have a tutorial in my new book on creating a tilt-shift effect with a timelapse sequence;

The tools are now easier to use, with on screen icons for most tasks. Here are a few examples of what I was able to create using Photoshop CS6 3D. The image of the pens and ruler were created entirely with the available 3D tools. The other two images were models I created in Maya and then imported, textured and composited in Photoshop.
saved with each document. You can choose to open a style from a document and grab the style.

A new feature in CS6.1 is global styles. You can now create one set of styles and use them over again.

Another feature of interest to web and multimedia designers is the ability to right click on an onscreen created element in Photoshop and save it’s associated CSS to a clipboard for use in Dreamweaver or Edge.

There are a couple of 3D updates; including better Raytrace and the ability to generate normals for better textures. This creates a displacement map type effect. Also GL effects have been improved with better preview of soft edges shadows and reflections as well as roughness. The default IBL (Image Based Lighting) is now better. So, overall, there are a lot of new things in Photoshop for you to explore and enjoy. My experience is much better speed for a number of tasks, and I love the expanded non-destructive features.

ABOUT THE AUTHOR

Colin Smith is a best-selling author, trainer, and award-winning digital artist who has caused a stir in the community with his stunning Photoshop work. Colin is also known as a pioneer of HDR photography. Colin is an Adobe ACP (Adobe Community Professional). He is founder of one the world’s most popular Photoshop resource sites, PhotoshopCAFE.com, which boasts over 30 million visitors.

With over 18 years of experience in the creative industry, Colin is a regular columnist for Photoshop User magazine. He has been featured in most major imaging magazines including, Computer Arts, Macworld, After Capture, PSD Photoshop, Advanced Photoshop, Photoshop Creative, Digital Photographer, Web Designer magazine and a host of others. Colin’s digital imaging work has been recognized with numerous awards, including, MacWorld Digital Design and 3 Guru awards at Photoshop World 2001 and 2002. He’s authored or co-authored more than eighteen books on Photoshop, including the best-selling How to Do Everything with Photoshop (McGraw-Hill/Osborne) and award-winning Photoshop Most Wanted, as well as being prominently featured in the Hall Of Fame book, New Masters Of Photoshop and New Masters of Photoshop 2 (The only artist featured in both editions). Colin is also creator of the Photoshop Secrets Video training series (PhotoshopCD.com). He is in high demand across the United States as a lecturer, presenting his Photoshop techniques to photographers and graphics professionals across the nation. He has been a speaker at such conferences as WPPI, Flash Forward, NVision, Photoshop World, PIDE, DL Expo, Creative Suite Conference, Cre8, Create Chaos, DeviantArt Summit and many more. In 2012 Colin was the featured speaker for a Multi-City Tour (Route CS6) Sponsored by Adobe. Colin has consulted such companies as Adobe Systems, Edison International, Apple and Disney Studios.

10 HOUR A-Z GUIDE FOR WORKING WITH PHOTOS IN PHOTOSHOP CS6

Save 10% use code SUPERGUIDE

www.PhotoshopCAFE.com/video
Once more Adobe couldn’t leave well enough alone (thankfully), and they’ve taken the brand new 2012 processing engine that powers the new Lightroom 4 and incorporated it into our beloved Adobe Camera Raw (ACR). This technological leap not only extends the capabilities of this invaluable image processing engine, but also dramatically increases the potential quality of the final results. Even though the way you work in the new ACR is significantly different in terms of how the sliders work in its foundational Basic panel, once you get used to it, you’ll find that it is completely indispensable for getting more than you ever thought possible out of your photographs!

A NEW SUPERCHARGED ENGINE - AGAIN!

Adobe achieved this quantum leap, especially as it relates to pulling out every drop of tonal detail in your image, by completely rewriting their raw “demosaicing” engine, just as they did in 2010. And fortunately, as in the past, ACR also processes JPEG’s and Tiff’s beautifully. What you will be able to pull out in terms of tone, color and detail is going to amaze you, but to access this new power you’re going to have to re-learn some of the ways you may have optimized your images in ACR in the past. And if you are new to working in ACR you’ll actually find version 7 is actually a lot more intuitive than previous versions. Let’s take a look at some of those differences.

A NEW BASIC WAY OF SCULPTING

Even though ACR 6 (the previous version) was incredibly powerful, the way the Basic panel (where the majority of your image enhancing takes place) was organized did not lead to the most intuitive way of working. Looking here on the far left are the default sliders and settings for ACR 6. The sliders already had default settings applied, and which portion of the tonal range was being adjusted by which slider (and how far the sliders could be “pushed” before artifacts were introduced) was a quandary for many.

If you open an image in the new ACR 7 that you have previously worked on in an older version, you will find a little “exclamation” icon in the lower right-
no longer need to worry if the highlights or shadows in your images seem compromised, they are still there and are happily waiting for your touch in the sliders below!

**CONTRAST**

Originally added to the Lens Corrections panel in previous versions of ACR, you also had to be careful of the Contrast slider because of the possibility of clipping information in the shadows and highlights in your image. Contrast still primarily manipulates the middle-tones in a photograph, but you will find that it's more forgiving than in the past, especially in the transition areas between the mid-tones and the highlights and shadows. But even with that forgiveness, for many images I recommend that you wait until later in your workflow process to adjust Contrast. In other words, use it once you've fine-tuned all your other options to add that extra little bit of punch or to soften harsh tones.

**HIGHLIGHTS AND SHADOWS**

You may suspect that the new Highlights and Shadows sliders are the same as the old Recovery and Fill Light sliders in the previous ACR, but nothing could be further from the truth. First, the Highlights and Shadow sliders are incredibly powerful in terms of what they're able to resuscitate in an image! The tonal range, even in a single image, can now often be beautifully extended to produce what used to require three or more separate images to create in an HDR (High Dynamic Range) composite (a god-send in once-in-a-lifetime action situations such as Brooke Christl’s Trash the Dress image)! Second, you’ll also notice that because the sliders now begin in the center of the bar, not only can you bring back or darken Highlight detail, but you may also safely increase the neighboring Whites for punch as well! Same goes for working with the Shadows slider: you can brighten up...
a lot of information in the shadows but you can also take this three-quarter portion of the total range and bring it down, without plugging up your blacks, which is exciting! The Blacks and Whites sliders also operate on these same principals. In earlier ACR versions, even though you had a Black slider, you were only able to darken your darkest darks, you could never lighten the amount of base blacks like you can do now with ACR 7.

To over-simplify these controls, these six sliders can be thought of as neighboring pairs: Exposure and Contrast control your middle-tone areas. Highlights and Shadows control your three-quarter and quarter tones. The Whites and Blacks sliders fine-tune the furthest extremes of your photograph’s range. If you think of these as three associated adjustments pairs, I think you’ll find it easier to wrap your head around the new sliders.

But wait… there’s more..

**CLARITY: POWER, BUT STILL WITH A CAUTION**

Even though the Clarity slider has the same name as in previous versions of ACR, it has been completely rewritten and now does a significantly better job of increasing apparent detail in an image without bringing in the “haloing” artifacts possible in previous versions. But because this edge contrast can be so significant, you might be lulled into a false sense of security and actually add too much contrast to these edges. Even though you won’t get the halos as you once did, you can still potentially plug up edge detail in certain images. So remember to zoom in and check your image when using excessive Clarity, you may find yourself adding a little bit more Shadow brightness, or a reduction in Contrast to compensate.

You can see in Brooke’s wedding dress shot that she significantly underexposed the image (wouldn’t you underexpose it if you only had ONE chance of getting THE shot of a bright shiny wedding dress and it’s inhabitant as they were about to meet Poseidon? ;). But even with this seeming lack of detail you will notice I was able to bring up the Exposure for the overall brightness of the image, then bring back in significant Highlight detail into the dress, once I had set the correct exposure. I was also able to pull out a huge amount of Shadow detail, taking it all the way up to 100% , without artifacts! I actually took the Whites UP in this file to add that satin sheen, yet maintain the Highlight detail! This is an amazing ability to fine-tune the entire tonal range of an image without the necessity of hand dodging & burning (we’ll get to Localized adjustments in a minute). Also, to bring in all the details in the water and dress the Clarity was set all the way up to 100%, without any artifact creation whatsoever, which would have been impossible in previous versions of ACR.

**NEW CAPABILITIES AND QUALITY**

Still not convinced? You say you could make shadows lighter and highlights darker in previous versions of ACR so what’s the big deal? The big deal is QUALITY! Take a look at this quick shot I took of a vintage motorcycle.
In previous versions of ACR if you were to significantly darken the highlight information and bring up the shadow detail you could get significant artifacting at that transition between highlights and shadows, as in the fringing of the trees around the motorcycle seat. In the current ACR 7, there is no such artifacting and the detail throughout the image is crisper and cleaner than I would have ever imagined from a single shot!

A single shot “HDR”? Yup! And with the taming of the edge artifacts that used to happen where highlights and shadows collide, there is finally peace in the previously Dramatic Range!

Actually, this image is something I’ve used in the past to teach how to combine five bracketed shots together to create one HDR image. Using ACR 7 you can definitely pull off exposures that could have only been achieved with multi-shot High Dynamic Range combinations in the past – talk about a time-saver!

THE PEN (OK... THE ADJUSTMENT BRUSH AND GRADUATED FILTER) IS MIGHTIER THAN THE SWORD!

If you were making a wish list for the Adobe Tooth Fairy (Russell Brown, are you listening?), and you had all these phenomenal capabilities added to the Basic panel, what would be the one additional characteristic that would make your creative darkroom dreams complete? Of course, you would want those capabilities added to ACR’s targeted Adjustment Brush and Graduated Filter! And that’s exactly what Adobe has done with the improvements in ACR 7, and more!

Not only have they added our new best friends of Shadows, Highlight and Clarity, they have also given us something that we’ve never had before: the ability to adjust localized color temperature using a brush or gradient! Even though you could do something similar to this before by adding the opposite color cast using the little color swatch in the Graduated Filter and Adjustment Brush panels, it’s not the same as actually using a temperature and tint slider to fine-tune and balance different color casts within an image. In this second Brooke Crystal wedding image we have a very warm interior artificial light balanced out with the cooler external sunlight by simply dragging out a Gradient Filter slider from the left to the right, with a tap toward the blue of the Temperature slider. And because Shadow resuscitation can now be put inside a brush or gradient as well, Adobe has also graciously added Noise Reduction to their localized adjustment tools, an incredibly useful feature when pulling out shadow detail that don’t want to come willingly!

CURVES UNLEASHED

Curves, one of the basic adjustments in Photoshop for the last hundred years, has been available in ACR for a while, with both Point Curves as well as the powerful Parametric Curves. But prior to ACR 7, we were unable to access the foundational Red, Green and Blue channels independently, but now you can. The benefit is that for the first time you can use separate Red, Green and Blue curves to fine-tune color casts and tonal information, but you can also use them for an immeasurable amount of special-effects enhancing to an image. Before ACR 7.0, this was really only possible in Photoshop. In this shot by Hal and Victoria Schmitt of LightWorkshops.com, we’re able to not only improve the tonal range of this portrait but also add a Cross Processing effect by shaping the total range of each one of the Red, Green and Blue channels independently of each other, allowing for a beautifully expressive enhancement, with absolute quality and control.
Another long-time use for curves has been for converting images to black-and-white, one of the advanced features in Photoshop we’ve used for ages. Now with the combination of targeted Curves and the already phenomenal Hue, Saturation and Luminance panel, we have the ability to further fine tune black-and-white images in ways never before possible, such as in this portrait of this beautiful little girl also by Hal and Victoria Schmitt. Red hair goes white, red cloak goes black – with no dodging and burning – figure THAT one out! ;)

**CHROMATIC ABERRATIONS BE GONE**

Chromatic Aberrations are the annoying colorful edge artifacts seen in contrasting highlights left by the minor misalignment of different color channels in images taken with certain wide-angle lens (see the museum skylight shot). Chromatic Aberration removal was built into ACR before, but needed a special profile for the specific lens to do the job well. What the mad scientists at Adobe figured out was that they were able to do a better job of removing these edge color artifacts using their own algorithms rather than relying on the profiles. Specifically, using the Remove Chromatic Aberration option (within the Profile tab within the Lens Correction panel) in concert with the Defringe
> Highlight Edges option (within the Manual tab of the same Lens Correction panel) allows you to virtually get rid of any sort of edge artifacting that you could possibly come across, all with a couple little clicks!

So there is a quick overview of just some of the improvements in the new Adobe Camera Raw 7. Now all the jaw-dropping and deadline-saving projects that you can DO with all that power, well, that would take an entire DVD to demonstrate (yes, that’s a shameless plug for my new Adobe Camera Raw 7 Enhancing and Lightroom 4 Enhancing titles from PhotoshopCAFE.com and WowCreativeArts.com)!

ABOUT THE AUTHOR
Jack Davis is one of the world's leading experts on Photoshop and Lightroom, as well as himself being an award-winning photographer. Jack is coauthor of a dozen different creative titles including the bestselling (a million copies+ in 12 languages) guide to Photoshop, The Photoshop Wow! Book, and How to Wow: Photoshop for Photography. For over 20 years Jack has been an internationally renowned spokesperson on digital imagery, and routinely teaching at conferences and workshops around the world. Davis is part of the “Dream Team” at the Photoshop World Conferences and was one of the first inductees into the Photoshop Hall of Fame for his lifetime contributions to the industry. Jack has an MA and MFA in Digital Imagery, and when he’s not in his studio in San Diego, he’s usually somewhere in Polynesia, iPhone and Big Boy camera in hand, capturing the local color.

For more about Jack, his training material and teaching schedule go to WowCreativeArts.com.

Adobe Camera Raw 6 For Digital Photographers

With Photoshop's ACR 6, Adobe has introduced tools that have the power to completely change the way we shape our photography. Instead of working one image at a time, one step at a time, now the vast majority of our photographic finishing can be done quickly, elegantly and nondestructively in one place! - without even opening Photoshop! This includes such universal tasks as dodging & burning, skin softening or even targeted sharpening! That's what Adobe Camera Raw 6's Localized Correction tools have brought with it to yield a highly increased workflow. You will have to see these techniques in action to understand just how powerful they are.

PhotoshopCAFE.com/VIDEO

It's not all Smoke and Mirrors
The most important thing in Photography is lighting.
The best of the best photography training anywhere!
Create knockout photos.

Intuos 5 touch

Intuos5 combines two tools in one: our finest pen tablet and multi-touch input. Use the pressure-sensitive pen for unparalleled precision. Navigate your work with familiar gestures. Save time by storing your favorite settings with the ExpressKeys."

Above all, immerse yourself in a natural, intuitive workflow as you edit, retouch and enhance your photos.

Learn more at: www.wacom.com
Photoshop CS6, What’s in it for tablet users? | Written By: Weston Maggio

With each update to Adobe Photoshop, tablet users enjoy a plethora of enhancements that make their workflow more productive and in some cases more enjoyable. Photoshop CS6 is no exception! What I am particularly interested in is what does this version bring to the tablet user? Again, CS6 does not disappoint. In my review of our favorite App., I have found a variety of features, both new and updated that will have tablet users cheering. Read on to learn, “What’s New in PS CS6 for Tablet Users”.

USER INTERFACE

Upon opening the App. for the first time, your eyes will likely widen as you find the user interface (UI) has been updated to the fast-becoming standard, dark look. Adobe and other application developers have been gravitating toward darker UIs as studies have shown that gray values have less effect on your perception of tonal values and saturation. For some this new dark UI may be distracting at first, or present some contrast issues with text (especially in panels). If you’d prefer the “old” look, or would like to adjust the contrast, you can change the appearance in the Photoshop > Preferences > Interface.

What does the color of the UI have to do with tablet use? Nothing, but you can’t skip the cover of a book before you open it! I’m not judging. It’s just the first thing you see. Ok, let’s look at something more relevant in the UI that every tablet user should be aware of. If you skipped the upgrade to CS5, or perhaps did not notice the addition of two new buttons that appear on the options bar, you missed a big feature for tablet users. When you have the brush tool selected, these two icons enable pressure sensitive control of the size and/or opacity of a brush stroke. The buttons are available once again in CS6 but they come with a more descriptive tool tip that should make them easier to understand, and thus used more effectively.

In short, when toggling either (or both) of these buttons to their on, or depressed position, you elect to control the size or opacity of the brush by pen pressure. This method overrides whatever controls have been assigned to a brush preset, meaning when the button is in the off position, pressure is controlled in the Brush Panel. Tip: For general retouching, I often select a basic soft round brush from the brush panel, and then toggle the control of the size and opacity of the brush (tip) using these pressure control buttons.

PAINTING

Perhaps the biggest news for tablet users is the work that Adobe has put into the drawing and painting features. There have been updates to the Brush Panel, tools, tips, presets, performance and more!

I’ll start with perhaps the most visual enhancement, the introduction of “erodible tips” (as in tips that wear down) and “airbrush tips”. Found in the Brush Presets panel, erodible and airbrush tips can be identified by a profile view of a shaved pencil and a traditional airbrush respectively. The unique characteristics of the erodible tips include the combination of wear and texture as you continue to use them. The result is the appearance of what you would achieve when using traditional soft, dry media. The more you rub, for example a soft pastel pencil, onto a textured surface, the more it would wear down (and build up). Like traditional media, when you need to sharpen a tip you can do so in the Brush Tip Shape pane of the
presets offer the artist, illustrator and painter some great new media options and styles to experiment with!

Something else that may grab your attention is an additional pane in the Brush Panel. “Brush Pose” enables you to set stylus parameters for Tilt (X and Y axis), Rotation and Pressure. Enabling these options override any pressure controls assigned in the brush preset. For example, users of an Intuos tablet or Cintiq interactive pen display, whose pen recognizes tilt, may opt to ignore tilt altogether or lock the angle of a brush while drawing. Additionally, users of Wacom’s optional Art Pen (which recognizes tilt, and rotation) can override the rotation of the pen. (For Bristle Tips, Erodible Tips and Airbrush Tips, you can see the effects applied in Brush Pose in the Live Tip Brush Preview. *Bristle Tips were introduced in Photoshop CS5.

Finally, a notable enhancement in the Brush Panel is the addition of a new option in the Color Dynamics pane. A check box now enables you to vary Color Dynamics on a per tip (or stroke) basis. When checked, Color Dynamics behaves as it has in the past. Random colors (between the foreground and background) are across the length of the stroke. Unchecking the box, maintains a constant color
per stroke. Each subsequent stroke varies based on the settings in the pane. A nice addition for those looking to add variety to their illustration and design work.

**HUD Brush Controls Update**

On the subject of brush control, those that have enjoyed the dynamic HUD brush resize function will be thrilled to see it enhanced to offer what is being dubbed as “rich-cursor information”. When you modify the size (diameter) and hardness of a brush using the drag-resize method, in addition to the visual representation of the brush attributes, you now get a textual readout of the Diameter, Hardness and Opacity settings at the cursor.

Additionally, you can now elect to change the function of dragging up/down from its default (hardness) to opacity. To change from Hardness to Opacity, in the General Preferences, uncheck “Vary Round Brush Hardness based on HUD vertical movement.”

Tip: To visually adjust the size and hardness (or opacity) of a brush, use the following key commands when pressing your pen to the tablet and dragging.

**Macintosh:** Change brush size: Option-Ctrl-drag left/right. Change brush hardness or opacity: Option-Ctrl-drag up/down.

**Windows:** Change brush size: alt-right mouse button drag left/right. Change brush hardness or opacity: shift-alt-right mouse button drag up/down

**TOOL RECORDING**

I want to make mention of the new tool recording feature. This new function enables you to record brush strokes as part of an Action. My initial thoughts on this feature was, how cool would it be to record an action that makes a tonal adjustment to an image, and then brushes on a mask to reveal only a portion of the enhancement? When playing back the action, you can literally watch the mask appear. If it reveals (or conceals) too much of the effect, simply modify the mask after the fact. Or, how about playing back a sketch? You can now record each brush stroke laid down in the creation of a sketch for later playback!

To enable the recording of normally non-actionable tools, select the Allow Tool Recording menu option in the Actions Panel fly-out menu. A note on playing back actions that contain brush strokes: When playing an Action that contains brush strokes, keep in mind that the tool used in the original action is honored, however the settings for that particular tool (including brush presets) are not. The brush settings in effect during playback will be used. i.e. Size, color, opacity and more.

**CAMERA RAW**

With the recent introduction of Lightroom 4 you may have seen a preview of what was to come in the next version of Adobe Camera Raw (vr. 7.) –Lightroom and ACR use the same RAW processing engine. You can now make local adjustments to Temperature and Noise Reduction. Additionally, ACR 7 brings new Black/White as well as Highlight and Shadow controls to the basic panel; replacing/updating the previous Recovery, Fill Light, Blacks and Brightness controls.

**PERFORMANCE – LIQUIFY AND OIL PAINTING**

Not all necessarily pen-centric, but welcome
performance updates have been made for anyone who pushes pixels—literally! Many of the resource intensive functions found in previous versions of Photoshop have been updated to take advantage of later model computers, and more specifically, new video cards. These functions, now take advantage of the GPU. Non-technically speaking, they are faster. Meaning, you can actually use them effectively!

One such function that I look forward to using more often is Liquify. In the past Liquify was extremely resource intensive, lagging at the slightest wisp of the pen. Now, a little nip and tuck, here and there can be gracefully applied with the subtle nuance of pressure.

With this update on performance also comes a new filter, Oil Paint. Oil Paint offers photographers and artists a nice starting point when turning photos into paintings. The interface enables you to vary the level of stylization and cleanliness (smoothness) of the virtual brush being applied, as well as a variety of depth, detail and lighting effects. All based on a combination of sliders. Once you’ve created a base layer for your painting in the Oil Paint interface, you can make it your own by applying a personal touch with the bristle tips brushes (which mimic traditional media) introduced in CS5.

**KUDOS TO JOHN**

To bring this What’s New review to a close, I would be remiss if I did not give kudos to the ever-brilliant John Derry who put in a significant amount of work into the development and use of the new erodible tips and airbrushes. His experience in art and technology have lent to a number of advancements in the evolution of creative applications. Specifically, those apps that combine the realistic look and feel of traditional media. The result of his efforts have given artists the ability to combine media that they never could traditionally, and at the same time, take advantage of all that digital media has to offer.

**ABOUT THE AUTHOR**

Wes Maggio is a long-time tablet user and Senior Solutions Manager at Wacom Technology Services Corp. He is a passionate trainer and speaker, presenting at various photography and design events around the world. He is also a contributing writer to numerous creative magazines and he is the co-author of the leading title on tablet training: Wacom Tablets and Photoshop CS6 from PhotoshopCAFE. Wes is the host and frequent presenter of “Wacom Webinars”, a series of live webinars offered monthly, as well as the manager of the popular blog, Tablet Gurus, “the go-to place for tablet users”. In his spare time, if he is not on a plane somewhere, he is literally running around town.

Photoshop Secrets
Wacom Tablets and Photoshop CS6
Weston Maggio & Colin Smith
NEW for Photoshop CS6
A “must have” for tablet users.

This is the 6th edition of THE best-selling video on Wacom tablets and Photoshop. The most complete training on the Wacom Tablet and Adobe Photoshop ever! This fully updated video will show you how to unleash the power and creativity that only comes from a pressure-sensitive tablet. Set up your tablet correctly and stop working like a mouse user in Photoshop. Two of the Top instructors in the industry combine their talents to bring you a video that will totally change the way you approach graphics on your computer.
Photoshop CAFE

TUTORIAL CATEGORIES

Removing a Photograph from it's background

Colin's 10 Principles for Better Type Design

Creating a filmstrip in Photoshop

Making semi-transparent selections with Alpha channels

PhotoshopCAFÉ.com

save 10%

CODE SUPERGUIDE

photoshopCAFE.com/video
Photoshop CS6 has undergone a number of upgrades and new features. One area that has had no stone unturned is the 3D tools. Here I’ll show you a workflow with the new features.

**WORKFLOW OVERVIEW**

Create a new file at 5x5 inches with a resolution of 200 PPI and type out text in all caps titled “PHOTO-SHOP 3D”. When done go to the 3D menu and select “New 3D Extrusion from Selected Layer”. Immediately you get an extruded 3D version of your text. Photoshop will ask you if you would like to switch to the 3D interface. I recommend that you chose to work in the 3D space as shown in figure 2. You can move, rotate or pan your 3D object by accessing the Move tool (V) and your options bar will show you various options for navigating the 3D object. You can toggle through these options (rotate, roll, drag, slide & scale) by using the Shift V on the keyboard.

You will see a small 3D widget that will allow you to move in the X,Y,Z axis where each axis is designated with a red (X), green (Y) and blue (Z) colors. Each is joined to a yellow cube, which designates the resize function for 3D objects. However, you can enlarge this widget to assist you in your workflow by holding down the Shift key on the keyboard then click and drag on the cube upward to enlarge the widget itself. You can also drag downward to reduce the size of the widget.

Take note that you will be working quite a bit in two panels which are the 3D & Properties panels. In the 3D panel you have the ability to access your Environment, Scenes, Cameras and any 3D object. Select the “PHOTOSHOP 3D” object and take note that the options for that object are shown in the Properties Panel. By default the Mesh button is selected on the top left corner. Select the “Extrusion Depth” slider to get a feel for extending the length of the text as shown.
Now select the Deform button to the right of the Mesh and practice tapering the text extrusion. You can use the sliders to achieve this or click & drag on the widget symbols to twist, taper or extrude. For now taper the text and use the “Deformation Axis” to set the directions. Use the next 3 figures as guides.

Next, apply Twist to the extruded text and notice how fast and easy Photoshop CS6 executes this command. Once done experimenting set the text back to a standard extrusion and let’s move on to beveling the text.

**APPLYING BEVEL TO THE EXTRUDED OBJECT**

Now that you have a feel on how to quickly extrude and modify text into a 3D shape, let’s learn how to apply a bevel to its surface.

Select the Cap button to the right of the Distort button in the Properties Panel. Near the bottom of the Properties panel, target Angle and Strength to get a bevel similar to what you see here.

Click on the Contour drop menu and you will see various options for creating a beveled edge effect. You can explore these as well as make some of your own.
Note: I have always found that changing the color designation for any of the selected 3D objects helped me in quickly finding my way around the 3D interface. Figure 13 shows some of my settings for visuals in the 3D space.

Near the bottom of the Properties panel you will see the Angle & Strength for the front inflation. This will balloon the face of the text outward or inward. The Angle controls the contour of the surface and the strength controls how far the surface will inflate or deflate as shown in the next 2 figures. Finally, apply a simple rounded edge bevel and let’s move on to texturing our 3D objects.

TEXTURING

Now that we have our objects they will not come to life until we apply an interesting surface to them. This is where we will explore how easy it is to apply preset or custom textures to our object.

In the 3D panel select the “PHOTOSHOP3D inflation material”. Note that all of your options for its surface show up in the Properties panel.

In the 3D Properties panel select texture preset sub-
menu and apply any preset that you like. Don’t worry about which one because we will change it later. Just practice on applying various textures.

Physically place the eyedropper the front face of the font and click to sample that texture.

If you end up with a bunch of surfaces and you plan to have the same surface for each one there is an easy way to copy and paste the same texture on all surfaces. Access the 3D Materials Eyedropper Tool on your tool panel.

Next, hold down the Alt/Opt key on your keyboard then click on the bevel of the text to apply the sampled texture to its surface. It’s that easy. Let’s talk about lighting next.

LIGHTING

Lighting in Photoshop CS6 Extended is a lot of fun. It’s fast and responsive with convincing results.

On the right of the 3D Panel click the light button and target the Infinite Light1. You should see a 3D representation of the light source in Photoshop. In addition you will see a shadow on the ground plane representing the direction & angle of the light source.
Take note that you can change the light angle by a Shift Click & drag the shadow on the ground plane.

To help us see how the shadow is affected by the light, let’s quickly set the shadow on the ground (3D>Snap Object to ground Plane). Note that the main 3D object folder must be selected in the 3D panel for this option to be active as shown in figure 21. You can change the direction of the light.

You can make additional edits to your objects that are new in CS6. Target the internal Constraints for the “P” key located inside 3D panel as shown in figure 22. This is the constraint that makes the hole inside of the “P” object. Next, focus on the Properties panel and you will see the “Delete Constraint” button. Click it to see the effects of deleting the targeted constraint. You should something like what is shown in figure 23. However, you can create your own custom constraints via selections. For now, just draw a select in front of “P” key using the Lasso tool and in the Properties panel select “Hole” from the submenu for Type and watch Photoshop accurately create a new constraint. Use the figure as a guide.
That's not all you can do with text. You can edit it as well while it's in 3D mode. Let's try it. Just right click over the text and you will get quick access to the Properties panel and click the “Edit Source” button on bottom of the pane.

CREATING 3D FROM PAINTED SHAPES
We are going to create a cliff for our text to sit on. We will do it using one of the square brushes in the Brush menu then extrude it into a 3D object.

Use one of the square brushes of your choice to paint a shape with black on a new layer.

Extrude the shape into a 3D object.

Change the text to “PS CS6 3D” Pretty cool … huh?
Note: Take note that you can see more than one camera view at a time. Click on the submenu for the additional camera view and select any view of your choice as shown in figure 30.

You switch the view to the main document by clicking the Swap Main & Secondary View button.

Let’s apply some texture on the cliff using a photo. Select the extrusion material for the cliff.

You should see something like this.

Let’s give the cliff some texture as well. So target the bump in the same panel and load a new texture with “texture-001 bump.jpg”. Increase the bump strength to your liking.

MERGE 3D OBJECTS

So far the 3D objects are on separate layer so to get them to interact within the same scene we have to merge them. Let’s go do it.

Select both 3D layers then merge them as a single 3D object (3D>Merge 3D Layers). Figures 35 & 36 show the before and after.
Apply “texture-003.jpg” to the front, bevel and extrusion of the 3D text. Adjust the light so that it is emitting from the extreme right corner at approximately 45 degrees of the text.

Apply “texture-003.jpg” to the front, bevel and extrusion of the 3D text. Adjust the light so that it is emitting from the extreme right corner at approximately 45 degrees of the text. Next, apply depth of field so that the focus favors the foreground then falls off toward the rear. Adjusts Distance and Depth until you get close to this.

With some additional texturing to the cliff figure 39 was achieved.

CONCLUSION
I hope that enjoyed this article and that it has helped to spur your imagination as to what is possible with 3D in Photoshop CS6 extended. Experiment much and practice often to come up with your own discoveries.

ABOUT THE AUTHOR
Stephen Burns (www.chromeallusion.com) has discovered the same passion for the digital medium as he has for photography as an art form. His background began as a photographer 28 years ago and in time, progressed toward the digital medium. His influences include the great Abstractionists & the Surrealists including Jackson Pollock, Wassily Kandinsky, Pablo Picasso, Franz Kline, Mark Rothko, Mark Tobey, and Lenore Fini, to name a few.

Stephen Burns has been a corporate instructor and lecturer in the application of digital art and design for the past 12 years. He has been exhibiting digital fine art internationally at galleries such as Durban Art Museum in South Africa, Citizens Gallery in Yokohama, Japan, and CECUT Museum Of Mexico to name a few. Part of his exhibiting won him 1st place in the prestigious Seybold International digital arts contest. He teaches Digital Manipulation Workshops Internationally as well as in his home town San Diego. He is an instructor on www.xtrain.com, Photoshop Café (www.photoshopcafe.com and a guest contributor to the Kelby Group. You will often see him as an instructor at Siggraph (www.Siggraph.org) Leading the Digital Artistry Workshops.

INTRODUCTION TO 3D IN PHOTOSHOP CS6
Stephen Burns

5 HOURS $49.99
Photoshopcafe.com/video
Congratulations to the finalists in Design Challenge #13. Our annual free design contest.

Thanks to our sponsors, Adobe and Wacom.

Check out all the entries and finalists from the past 12 years.
http://www.photoshopcafe.com/contest.htm
Photoshop has never been known for its 3D abilities. It is really better known as Adobe’s primary-pixel-pusher. The inclusion of 3D objects and Repousse in previous versions marked interesting forays into the realm of ray-traced three dimensions. But the cumbersome workflow and less than stellar results turned away many who would otherwise welcome the new tools into their production workflow. In Photoshop CS6, Adobe has taken great pains to overcome that perception. New features, enhanced workflow, and smoother, more reliable performance all come together to make the 3D features of CS6 extended something worth paying for.

Gone is the term “Repousse” and good riddance! It has been replaced with the much more sensible term, “3D extrusion.” That’s a term that even we can figure out what it means! Adobe has also created an innovative new approach to modifying the properties of the 3D elements. While using the 3D tools, objects have their own modifier displays, such as transformation cages and bevel adjustments that can be accessed right on the canvas. Even the smoothness of shadows can be adjusted by dragging on the shadow! The old slider bars are still there, but it is entirely possible to create, move, edit and adjust 3D objects without ever having to visit the panels.

This tutorial will demonstrate some of the new 3D features and workflows available in CS6. For the project, we took some inspiration from the Inception movie posters and decided to spell the word Bicubic in large letter shaped buildings within a city. (Because the bicubic smoother interpolation is used for enlarging images in Photoshop!) Fair warning, this tutorial does contain some rather advanced compositing steps that are aimed at the more experienced user, but those are not the focus of the project. The primary point is to explore the 3D features and workflow, so most of the instruction is spent on those steps.

**BICUBIC TUTORIAL STEPS**

**Step 1 - Stock Image Selection**

The success of the entire effect rests on the quality of the base image. The shot needs to be drastically vertical so the roofs and building shapes are clearly visible. A lower, more oblique angle and the letters will not be recognizable. The shot you see here is from fotolia.com (#826018). Then use the new crop tool in CS6 to trim it down to the working area shown here.

**Step 2- Bicubic Buildings**

Add in the text using a simple no-serif font, Arial works nice in this case. Then with the type tool still active check the Options bar for a new 3D Extrude icon. Press it and Photoshop switches to the 3D work-
space and extrudes the type. Select the Bevel from the Shape presets and set the Extrusion Depth to 1.25.

**Step 3 - Build a Ledge**
At the bottom of the workspace, you can switch from one layout to the other, using three tiny icons which represent the Mobile size, Tablet size, and Desktop size designs. When you change from one layout to another, the corresponding CSS is applied to the document displayed in Dreamweaver’s workspace. Remember, you’re only working on one HTML file, but because Dreamweaver creates three sets of styles, you can rearrange and resize the elements to create three different layouts.

**Step 4 - Turn Entire Buildings on End**
With the Bicubic 3D text still targeted press the 4th icon in the properties panel for Coordinates. Enter 90 into the X rotation field to turn the letters up on their end. Then go to the 3D menu and choose Snap Object to Ground Plane.

**Step 5 - A Different Perspective**
Click on the Current View line in the 3D panel and make sure the Move Tool is active. Photoshop immediately activates the 3D camera tools. Use these to rotate, pan, and zoom around the scene until the buildings fit into the proper perspective.

**Step 6 - Break up the Block**
Currently the entire word is considered one single mesh to Photoshop. In order to assign different textures and properties to the individual buildings, they must each be a unique 3D element. To do this go to 3D->Split Extrusion. Notice in the 3D panel that Photoshop creates a separate 3D object for each letter.

**Step 7 - Create Textures**
Now it’s time to turn some attention to the texture maps. Open the original stock image again and find a clear, unobstructed view of a building side. Create a selection of that side and copy it to a new document. Then use the new Perspective Crop tool (found behind the regular Crop Tool) click on each corner of the map...
and the tool will remove the perspective and square off the texture. Continue with this process until you have enough side and roof textures for each building.

Step 8 - Basic Texture Mapping

Back in the project file, open up the 3D object layers in the 3D panel until you can see the Material entries. Select the “B Front Inflation Material” and in the Properties Panel click on the document icon next to the Diffuse attribute. Load one of the roof materials to map here. Use the same method to map a side texture to the Extrusion material. For the Bevel material, click on the color chip to assign a color that can be sampled from the adjoining textured surface. Continue on until all the letters are fully mapped.

Step 9 - Move the Sun

Select the “Infinite Light 1 item” in the 3D panel and use the on-canvas editor to adjust the light direction to match the base city image, so the light is coming from the top left. Use the Add Light icon (in the base of the 3D panel) to create another infinite light to serve as a fill light. Reduce the intensity of this light and align it to light up the shadow areas so they are not fully black.

Step 10 - There’s a Render Button!

Press the Render button (no more quality drop down menu to start a render!) in the base of the Properties panel and wait as Photoshop renders out the image. Depending on your system strength this might take a while. Notice that CS6 even has a Time Remaining status bar in the lower left corner.
Step 11 - Let’s Start Compositing

At this point you can Rasterize the 3D layer (Layer>Rasterize>3D) to make it available for filters and painting tools that will help in the compositing process. Next, use the Pen Tool to trace around the foreground buildings. Make the full path go up and around the rendered buildings and use the path as a vector mask on the 3D buildings. The new letters should tuck nicely in behind the foreground buildings.

Step 12 - Shuffle Buildings Around

The background image needs some adjustments so the render fits seamlessly into it. Duplicate the layer and work on the copy. Create a selection around the tall white building in the lower right. Use the New Content Aware Move tool to shorten the building so it doesn’t obscure the new buildings. Otherwise, Clone Stamping and Content Aware Fill are the primary tools for this step to remove or relocate buildings that are in the way of the new letter buildings. Simulated shadows can be created by creating a feathered selection and using the burn tool.

Step 13 - Lighting Adjustment

It’s unlikely the rendered lighting will exactly match the background image, so use a Curves adjustment layer to correct any discrepancies. Clip the adjustment layer to the rendered layer by pressing the first icon at the base of the Properties panel. Clip a Shadow layer on top of this (by holding down the alt/opt key while clicking between the layers) and use a black to transparent linear gradient to add shadows to the base of the buildings.

Step 14 - Collect the Roof Clutter

While the rendered textures for the roofs are impressive, they don’t quite look photo realistic. Create a new Roof Patch group for each building to start copying additional architectural elements from elsewhere in the image. Open the original stock photo and use it as the source for the Clone Stamp Tool to clone elements into the project file. There are plenty of cranes, AC units and vents available to choose from!

Step 15 - Highlight Blowout

The original photo is a little overexposed. To match
that condition create a merged layer at the top of the layer stack by holding down the alt/opt key and going to Layer>Merge Visible. Then ctrl/cmd click the rendered layer’s thumbnail to load that shape as a selection. Hold down alt+ctrl+shift (opt+cmd+shift) and click the mask thumbnail to intersect this with the mask shape. Use the resulting selection as a mask on the merged layer. Set the blending mode to linear dodge and reduce the opacity to around 50%.

Step 16 - Final Effects

Add a Hue/Saturation adjustment layer to the top of the stack. Check the colorize box and adjust the sliders to get a sepia hue (39, 32, -1 works well). Add a Vignette layer on top and fill it with 50% gray through the Edit>Fill command. Run the Lens Correction filter and look in the custom tab for the slider to add a dark vignette. Finally set the blend mode to Overlay to make the gray invisible.

Remember, the key to creating responsive designs is to position the same divs for best display in each of the three layouts. For example, in the mobile version, the best practice is to create a single-column layout, but in the tablet and desktop versions, you may want to position the same divs to create two or more columns. Here is the Final Image.

OTHER HELPFUL TIPS
GET SOME HELP FROM VANISHING POINT

It can be somewhat challenging to get the 3D ground plane to match the photo perspective. Here’s a tip that can help. First create a new layer and go to the Vanishing Point filter. Draw out a grid that matches the ground of the photo. In the options flyout menu, select Render Grids to Photoshop. Then press OK and you will have a grid to help visually align your 3D Ground Plane!

RENDER SELECTION

It’s likely that the initial setup of textures and lighting isn’t exactly what you want. Chances are you will need to render a few times to tweak settings to get
everything just right. Don’t waste time rendering the entire scene time and time again. Create a selection of the area you are working on before pressing the render button. Photoshop renders only the selected pixels. This can be a huge time saver!

**SECONDARY 3D VIEW**

CS6 includes several new interface elements when working with 3D. One of the most helpful is a secondary view of the 3D object. Go to View>Show>3D Secondary View to get the floating window showing the 3D object from another perspective. This can be extremely useful when positioning objects and lights.

**CREATING TEXTURE MAPS**

Texture mapping is an art unto itself! The basic idea here is to copy a portion of the photo and use it as a wrapper on the 3D element. To make sure the texture maps are seamless, use the Offset filter (Filter>Other>Offset) to wrap the texture around the canvas sides so you can see how the edges join together.

**EDITING UV PROPERTIES**

If a texture appear stretched or squashed when applied to the building sides, the UV properties need to be adjusted. Frequently a texture needs to be repeated many times as it wraps all the way around the building. Click on the same icon used to load the texture map and select Edit UV Properties. This brings up the Texture Properties. Adjust the scale and offset values needed.

**CLONE FROM A DIFFERENT DOCUMENT**

Did you know the clone tool can source from one document and paint in another? While creating the architectural elements for the roof “clutter” in this project, open the source stock image side by side with the project file. With the Clone Stamp tool alt/opt click in the stock image and then go to the project file to paint. Photoshop clones pixels from one document to another!

**CONCLUSION**

This is really just the tip of the iceberg when it comes to the potential of the new 3D features in Photoshop CS6. The very same technique used here to map a texture to a diffuse color of an object can be used to control many other properties of the 3D objects. Specular maps can be used to make certain areas appear shiny while others are matte. Opacity maps control the visibility of a surface; these can be utilized to create invisible areas or holes in a surface that would not be possible to create otherwise. Mapping a grunge texture to the Roughness property can go a long way to breaking up the perfect computer generated appearance of a rendered surface. The list goes on and on.

The possibilities don’t end with the texture mapping either. The extrusion options are not limited to a straight extrude with a beveled edge. The twist and bend extrusions make it possible to create springs or twisted shapes. The revolve extrusion allows for easy creation of rounded objects like glasses or bottles. Additionally, Photoshop can import several popular 3D files from other packages to work with as well. The support of improved reflections and refractions, Image Based Lighting, as well as in-camera depth of field makes it possible to create photorealistic renders in Photoshop, it’s easier than we ever imagined.

Most 3D artists will tell you that 90% of their rendered work ends up in Photoshop anyway. When time is money and you are on a deadline, it is much easier and faster to clone out a stray polygon or make lighting corrections with curves than it is to tweak a setting and re-render an entire scene again. So being able to create or edit 3D work in the same program used to retouch it means fewer return trips between
applications and less digging through folders to find
the correct rendered file. This streamlines and consoli-
dates the production pipeline.

Photoshop’s 3D features are now worthy of being
noticed. If you’ve never tried them before, now is the
time. With CS6, these tools have leveled up!

ABOUT THE AUTHOR
Kirk Nelson. Kirk is an Adobe Certified Expert,
Freelance Author, Trainer, Speaker, Friendly Neigh-
borhood Graphics Geek. www.thepixelpro.com
Adobe Illustrator CS6, is featuring new tools, enhanced tools and productivity tools that enables the artist, designer to work more efficiently, with larger and more complex files. Spend less time waiting, more time creating.

**TOP FEATURE LIST:**

- Efficient, flexible interface:
- Dockable hidden tools
- Adjustable UI brightness
- Color panel enhancements
- Type panel improvements
- Transform panel enhancements
- Transparency panel improvements
- Control panel enhancements
- Image Trace
- Pattern creation
- Mercury Performance System
- Gaussian Blur enhancement
- Gradients on strokes

**EFFICIENT, FLEXIBLE INTERFACE**

**ADJUSTABLE UI BRIGHTENS**

New controls in Illustrator Preferences include adjustable UI brightness to keep the focus on your artwork. With smooth, continuous control of the background’s grayscale, you can quickly match the look of Adobe tools such as Adobe Photoshop and After Effects.

**DOCKABLE HIDDEN TOOLS**

Tear off and dock tools with more flexibility than ever. Find your frequently used tools and created your own tool workspace. In the Tools panel at the left, click and hold the Pen tool to reveal hidden tools. Tear off the tools by clicking the vertical bar at the right of the tool area. Simply drag the tools over to the right margin of the toolbar to activate the blue line that indicates you can drop the tools to dock them. Click on the arrows to arrange the tools vertically or horizontally.

From the Preferences Menu (Command/Control K) click on USER INTERFACE.

True white canvas color set your workspace canvas to White for fast color sampling when you need to quickly grab a pure white.
PANEL ENHANCEMENTS

Many of the panels in Illustrator CS6 have been improved so that you can work with your favorite tools more easily and smoothly than ever before. Now we can name the layers and Artboards by double clicking on the name to change it.

In the Color panel, extending the option will reveal a bigger area of colors and you can edit hex values directly or copy and paste into HTML code or into other Adobe tools.

In the Character Panel you can choose type style directly from the panel. Choose type options.

TRANSFORM PANEL

Long awaited feature, the ability to access the critical Scale Strokes & Effects option right in the Transform panel.

TRANSPARENCY PANEL

Now you can create/Release Opacity Masks as quickly as a click on a button right in the Transparency Panel.
CONTROL PANEL

Control panel more efficient with increased consistency, including placement of anchor point controls, clipping masks, envelope distortions, and more. As well as the ability to reset the workspace to a default position by clicking on the Reset work space.

IMAGE TRACE

Convert raster images to editable vectors using a completely new tracing engine. With this new approach to tracing, you can quickly get premium results with image sensing that automatically applies the most appropriate preset. And you have ultimate control in an Image Trace panel that surfaces options all in one place. Not only is the interface more intuitive and interactive, you get clean lines, accurate fitting, better color recognition, and reliable results thanks to brand new underlying technology. Use either the context-aware Control panel or the Image Trace panel to quickly apply.

PATTERN CREATION

After tracing an image or drawing a shape we can create a pattern using the New Pattern Creation Panel. With the New Panel the creation of seamless Pattern are not only feasible, but creatively fun. Using a completely new approach, you can experiment freely with different types of repeating tiles and pattern shapes that can be edited at any time. The new Patterns Options panel provides easy access to controls for maximum creative exploration enhanced by instant previewing.

Starting with a simple Trace or Shape

Use the Pattern Tile tool to resize the tile area and adjust tile spacing—right on your artboard.
See that newly created patterns are automatically saved as Swatches. You can then quickly apply them using the Appearance panel.

**Gradients on Strokes**
Apply gradients to your strokes—along the length, across the width, or within the stroke itself—all with complete control over placement and opacity.

**Mercury Performance System**
Mercury Performance System Work with precision, speed, and rock-solid stability on large, complex files due to native 64-bit support on Mac OS and Windows. Full use of all the RAM on your system enhances overall performance optimization and is apparent in many different ways. For example, the Mischievous Venus artwork has hundreds of layers, many with multiple effects applied. In this piece, the background was created by using Pathfinder tools on the texture—in seconds rather than minutes. Working smoothly with this complex a file would not have been possible prior to the release of CS6.

**Gaussian Blur Enhancement**
Gaussian Blur and effects such as drop shadows and glows are significantly faster than before, and interaction with the tools is improved. With Gaussian Blur, you can now set blur radius using a slider and preview instantly, directly on the artboard, rather than in an intermediate dialog box.

**Extra Enhancement**
Quitting Illustrator? Now you can purge unwanted data from your clipboard to quit faster.

I am sure there are some more hidden gems! Keep creating and exploring!

**About the Author**
Chana Messer Fine Artist, Designer, Trainer and Software Evangelist
Teaching at the university level for 25+ years in the fields of Fine Art, Digital Imaging in the Departments of Visual Arts at UCLA. Lead Instructor at the Walt Disney Company.
Chana is an Adobe Certified Expert, Adobe Partner, Adobe Community Professional, part of the Adobe Professional Freelance Team, and an Adobe User Group Manager. As such she has been invited to present at Adobe events at Mac World and AIGA, Adobe MAX and other events in Los Angeles, San Francisco, Portland, Chicago, New York and Tel Aviv.
The recipient of a BFA from Tel Aviv University and advanced degree in printmaking from Pratt University, Chana Messer has been a fine artist for over 30 years. Pursuing her interest in an emerging new field, Chana completed an advanced degree in Computer Graphics in 1986, and has remained ever since at the cutting edge of electronic digital design.
Chana is an exhibiting artist you can see her work at: www.chanamesser.com http://www.artpic2000.com/artists http://www.facebook.com/Chanaart
With all the hype around HTML5, CSS3, and responsive design, it’s no surprise that the hottest new features in Dreamweaver CS6 are all aimed at making it easier for web designers to create pages that adapt to small and large screens and use the latest flavors of HTML and CSS.

From the relatively minor addition of the new Web Fonts Manager, to the significant addition of the Fluid Grid Layout system, there are many reasons to upgrade to Dreamweaver CS6.

In this article, I’ll review the most significant changes you’ll find in this version of Dreamweaver, and offer a few tips and techniques to help you put them to work right away.

CREATING RESPONSIVE DESIGNS WITH FLUID GRID LAYOUTS

The most impressive new feature in Dreamweaver CS6 — and the one that’s sure to get the most ‘buzz’ — is the new Fluid Grid Layout system.

If you’re still trying to understand why you’d even need a Fluid Grid Layout and what responsive design (sometimes called adaptive design) is all about, consider this: Today’s web pages are as likely to be viewed on a tiny smartphone screen as they are to be displayed on a 27-inch Apple Thunderbolt Display.

Although you could create multiple versions of your website, each optimized to fit a different screen size, that’s a complicated and highly inefficient solution to a problem that’s only going get worse as people connect to the Internet with everything from wristwatches to refrigerators.

Responsive Design offers a far more elegant solution by creating one page that adapts to different screen sizes. Essentially, you create one HTML document and then use multiple sets of CSS rules to rearrange and resize the images, div tags, and other elements on that page to fit different screen sizes.

As a browser identifies the size of each screen that visits your site, the corresponding set of style rules is automatically applied based on a media query. The @media rule for media queries is not new, web designers have long used it to associate an alternate set of styles when a web page is sent to a printer.

Dreamweaver’s new Fluid Grid Layout gives you a head start on a complex design strategy. Like most responsive designs, a fluid grid layout includes three sets of style rules:

A small design optimized for mobile phones (and people with “fat fingers”);

A large design that fills even the largest computer monitors and takes advantage of all that screen real estate; and A mid-sized design optimized for iPads and other tablets.

When you use Dreamweaver’s Fluid Grid Layouts, media queries are created for you, based on the size of each device. Here’s what the media query looks like for a tablet device (note that the first line is a comment):

/* Tablet Layout: 481px to 768px. Inherits styles from: Mobile Layout. */

@media only screen and (min-width: 481px)

HOW TO USE DREAMWEAVER’S FLUID GRID LAYOUTS

You’ll find the new Fluid Grid Layout option under the File menu. You’ll also find it in a new category in the New Document Window. The steps that follow will get you started with this new, adaptable approach to web design.
Desktop size designs. When you change from one layout to another, the corresponding CSS is applied to the document displayed in Dreamweaver’s workspace. Remember, you’re only working on one HTML file, but because Dreamweaver creates three sets of styles, you can rearrange and resize the elements to create three different layouts.

**Step 1**

Choose File > New and in the New Document Window, select the Fluid Grid Layout category. In this dialog, you can change the number of columns that make up the grid for each of the three target sizes, you can specify the percent of the column width that is used in each of the margins between columns, and you can specify the total percentage of the browser window that will be filed by the grid layout. You can also use the DocType drop-down to select the version of HTML you want to use.

**Step 2**

When you click Create, Dreamweaver prompts you to first save a CSS file that includes the initial styles for the page. Simultaneously, Dreamweaver saves a boilerplate CSS style sheet, and a Javascript file, which are listed in the top of the workspace. Note that the HTML file that Dreamweaver generates is not saved in this initial step.

**Step 3**

At the bottom of the workspace, you can switch from one layout to the other, using three tiny icons which represent the Mobile size, Tablet size, and...
Step 6

As you add Fluid Grid Layout divs, you can resize them by clicking and dragging on the corners of each div. As you resize them, the divs will automatically snap to the closest grid line. Warning: If you view the corresponding styles that are automatically created in code view, you will see that the sizes are specified to the fourth decimal point, like this: width: 48.2758%. Resist the urge to round off these numbers. If you change these numbers in code view, Dreamweaver will no longer automatically adjust them for you.

Tip: When you resize a layout div by dragging from right to left, you make the div physically smaller. When you drag from left to right, you add margin space to the left side.

Step 7

To create multiple columns, click on the small arrow to the right of any resized div. After a div is moved up, a new arrow appears in the bottom left that you can use to move it back down.

Remember, the key to creating responsive designs is to position the same divs for best display in each of the three layouts. For example, in the mobile version, the best practice is to create a single-column layout, but in the tablet and desktop versions, you may want to position the same divs to create two or more columns.

USING DREAMWEAVER’S NEW WEB FONTS MANAGER

Another welcome addition to the world of web design is the ability to use almost any font to format the text on your pages. However, before I tell you about the new Web Fonts Manager in Dreamweaver CS6, I should warn you that you may not need it. In the ever-evolving way of the web, there are two basic ways to work with fonts:

• Host the fonts on your own web server
• Link to fonts hosted on someone else’s server

If you use the fonts at Typekit.com, which was recently acquired by Adobe, you don’t need host your own fonts and, as a result, you won’t need the new Web Fonts Manager in Dreamweaver. With Adobe Typekit, you create a collection of the fonts you want to use at Typekit.com, then simply use them in your styles. When you publish your pages to a server, the
fonts are automatically made available.

You only need Dreamweaver’s new Web Fonts Manager if you host your own fonts on your own server. There are two challenges with this option: first, you need the legal rights not only to use the font, but to publish it to a web server (check the fine print), and second, you have to host each font in four different versions if you want your fonts to display properly in all of the latest web browsers on both Mac and Windows. You can solve all of the challenges of managing font formats and rights if you use a service such as FontSquirrel.

**Step 1**

Download one of the many @fontface font kits from FontSquirrel.com and unzip the font folder.

**Step 2**

Choose Modify > Web Fonts, and click on the Add Font button in the Web Fonts Manager dialog window.

**Step 3**

Select each of the font types using the Edit Web Font dialog. FontSquirrel’s font kits come complete with all four of the font types you’ll need. If you save all four font types in one folder, Dreamweaver makes it easy to link to all of them at once. Just select the first by clicking on the small folder icon in Edit Web Font dialog, and Dreamweaver will find and load all four types automatically.

**Step 4**

Use the font in a style rule definition. Any fonts you add using the Web Fonts Manager are automatically included in the Font-family drop-down list in the CSS Rule definition dialog. This makes it easy to add those fonts to your style rule definitions.

**Step 5**

After you define a style rule that uses your fancy new font, you can apply that style as you’d apply any other style in Dreamweaver. Just remember that you won’t see that font displayed in Dreamweaver until you click the Live button at the top left of the workspace, or preview the page in a web browser.

**Step 6**

When you add fonts using the Web Font Manager, Dreamweaver automatically creates a webfonts folder and stores them in your local site folder. Make sure that when you upload the page where the font appears, you also upload the webfonts folder to your server.

**CREATING CS6 TRANSITIONS**

One of the most eye-catching aspects of CSS3 is the ability to create transitions. With CSS3 Transitions, you can change a style property from one state to another, over a specified period of time. You can create dramatic effects by using Transitions, such as making an image disappear quickly, or slowly fade away, when someone clicks on it. You can even create simple animations by changing the position of an image (or everything in a div tag) from one location on a page to another using a Transition.

You can set up Transitions with a variety of triggers, including the active link state (on mouse click) or hover link (on mouse over), and you can use Transi-
tions to make common actions on a web page happen more smoothly. For example, instead of having a link change color from blue to yellow when a visitor rolls a cursor over it, you can transition through a series of colors. Similarly, you can use a Transition to make a drop-down menu ease open, instead of popping open in one abrupt action.

One of my favorite uses of a CSS Transition is to create a cross-fade between two photographs. You used to have to use JavaScript and a lot of complicated code to create a fade, but thanks to CSS3, you can now achieve this effect by placing one image on top of another and then gradually reducing the opacity of the first image from 100% to 0.

Dreamweaver CS6 adds two new features to help you create CSS3 Transitions: a new CSS Transitions panel, and a new Transitions Category in the CSS Rules Definition dialog. As with anything in CSS3, there are a few steps to setting up a cross-fade.

**Step 1**

Insert two images into the same place on a page. To achieve this overlapping of images, I inserted a div tag into the page and inserted both, one above the other, using Insert > Image. Here’s what the code looks like:

```html
<div class="photo-transition">
  <img src="images/Tower-Bridge-430.jpg" />
  <img src="images/Tower-Bridge-midday-430.jpg" />
</div>
```

**Step 2**

To position one image above the other and set up the opacity, I defined these corresponding styles in my style sheet.

```css
.photo-transition {position: relative; height: 317px; width: 430px;}
.photo-transition img {position: absolute; left: 0; opacity: 1;}
```

**Step 3**

With my images in place, I opened the CSS Transitions panel by choosing Window > CSS Transitions. Like other panels, it can be floated on the screen or docked at the side. I find it fits in well with the CSS Styles and AP Elements panels.

To create a new transition, click the plus (+) in the CSS Transitions panel, and the New Transition dialog opens.

**Step 4**

As you can see in this figure, I selected the style .photo-transition img that I had already created as the target rule. Then, I used the Transition On dropdown list to set the transition to begin on mouse over by choose hover. I set the Duration to 1 second, the timing function to ease-in-out, and the end value to 0.

Note that because I’d already set the opacity in the style to 1, setting the End value for the Opacity property to 0 is what causes the top photo to fade out when a visitor rolls a cursor over the image.

Photo credit: Tower Bridge photos from istockphoto.com.
Step 5

In this figure, note how the second image becomes visible when the transition is complete. In the code, shown in the left side of this figure, you can see that Dreamweaver has created the CSS needed for all four of most popular web browsers using their respective browser prefixes: webkit for Google Chrome and Apple Safari, moz for Mozilla Firefox, ms for Microsoft Internet Explorer, and O for Opera.

Creating Text Shadows, Gradients, and Rounded Corners

Although Adobe included these features for the most popular CSS3 design options to Dreamweaver CS5.5, I wanted to include a few quick tips about how to use them in this SuperGuide, because many Dreamweaver users skipped version CS5.5, and I don’t want you to miss these important additions when you upgrade to CS6.

You can create class or ID styles with text shadows or drop shadows, and you can add shadows to existing HTML elements by defining a tag style, such as the style I created for the <h1> tag to create the text-shadow on the words Tower Bridge in this figure.

Creating Text Shadows

When you create rules that include text shadows you can specify up to four values. The horizontal and vertical fields specify the distance the drop shadow extends below (horizontal) and to the sides (vertical) of the text. The blur radius specifies the amount of blur in the shadow. The color of the shadow can be defined using a hexadecimal color code or as an RGBA color code.

You can add a text shadow using the Property pane at the bottom of the CSS Styles panel, as shown in this figure. To do so, follow these steps:

Step 1

Click to select the name of a style in the CSS styles panel.

Step 2
Click the Add Property link in the left side of the CSS Styles Property pane

**Step 3**

Select the property name, text-shadow, from the drop-down list, or type it into the field.

**Step 4**

After the name appears in the left side of the pane, a small arrow appears on the right. Click to select the arrow and open the text-shadow settings.

**Step 5**

Enter the X and Y offsets, blur radius, and color, and press Return/Enter. Note: you can have the text shadow appear above or to the left of the text by entering negative numbers, such as -3, in the X and Y fields.

Dreamweaver automatically generates the CSS3 code that creates that text shadow and includes it in the selected style rule definition.

**CREATING ROUNDED CORNERS AND OTHER CSS3 STYLES**

Similarly, if you want to add rounded corners to a style, or almost any other CSS3 style rule, you first select the name of an existing style in the CSS Styles panel, then click Add Property in the CSS Styles pane and choose the name of the property. For rounded corners, you add the property Border-Radius. Dreamweaver CS5.5 and CS6 include pop-up dialogs, like the one shown here, to help you create the style rules for these popular CSS3 options.

**WHY CAN’T I SEE MY FONTS, TRANSITIONS OR OTHER COOL CSS3 EFFECTS IN DREAMWEAVER?**

One of my biggest frustrations with Dreamweaver CS6 (and version 5.5 for that matter) is that design view, which is supposed to show you what your web page will look like in a web browser, is woefully outdated. As a result, when your pages are displayed in design view, they look like they are displayed in a very old web browser, which means you won’t see any of your CSS3 style rules applied, and elements in your layout may not line up the way they will in the latest web browsers.

To get a better idea of what your page will look like in the latest versions of Chrome, Safari, and other browsers, you’ll need to click on the Live button at the top of the main workspace.

Unfortunately, many of Dreamweaver’s editing functions don’t work in Live View, so you’ll need to click the Live button again to go back to editing your page. With a little practice, you can get used to compensating for these design differences, but it does make Dreamweaver’s design view a less than ideal place to, well, design web pages.

And remember, to fully test what your web pages will look to your visitors, you must test your pages in at least the last few versions of all of the most popular web browsers. For that, Adobe’s BrowserLab, which you can use by choosing File > Preview in Browser > Adobe BrowserLab is a great tool because it enables...
you to preview your designs in a variety of web browsers before you publish them on the web.

ABOUT THE AUTHOR

Janine Warner’s best-selling books and videos about the Internet have won her an international following and earned her speaking and consulting engagements around the world.

She is the creator of DigitalFamily.com, and runs a full-service interactive agency that offers web design services, iPad App. development, content strategy, and internet marketing.

Janine’s skills as a “techy translator” helped her land the deal for her first book in 1996. Since then, she’s written or coauthored more than 25 books about the Internet, including Web Sites DIY For Dummies, iPhone & iPad Web Design For Dummies, and every edition of Dreamweaver For Dummies. She’s also created more than 50 hours of training videos about web design and Internet marketing.

As a young reporter in Northern California in the mid-1990s, Janine recognized early that the Internet would transform traditional media and set out to learn everything she could about this new way of communicating. She studied HTML, FTP, LOL, ROFLMAO and countless other acronyms.

Janine’s early Internet projects included helping a creative director in Sausalito to manage a quirky team of programmers in Siberia, designing a virtual scanning system in a simulated futuristic store for Levi Strauss, and building one of the first newspaper websites in the country for the Pulitzer Prize-winning Point Reyes Light.

In 1998, her experience as a journalist and Internet consultant, combined with her fluency in Spanish, took her to The Miami Herald, first as the Online Managing Editor and a year later as Director of New Media. She left that position to serve as Director of Latin American Operations for CNET Networks.

Janine has taught online journalism courses at the University of Miami and the University of Southern California. She’s also been a guest lecturer at more than 20 other universities in the U.S. and Latin America, and she helped create an Internet Literacy program for high school students in Central America.

She is a member of the TV Academy’s Interactive Media Peer Group and has served as a judge in the Interactive Emmy Awards, the Knight News Challenge, and the Arroba de Oro Latin American Internet Awards.

In recent years, her experience as an Internet strategist and media executive has taken her to Moscow, where she helped develop a strategic plan for one of Russia’s largest publishing companies; to New Delhi, where she was a featured speaker at Internet World India; to Colombia, where she spent two months traveling around the country to lead Internet seminars at 16 newspapers; and to Southern California, where she helps craft the online image of actors, executives, and businesses, and occasionally takes a break to run on the beach.

Learn Dreamweaver CS6: Designing for Multiple Screens
with Janine Warner

With all the hype about designing web sites for mobile phones and tablets, it’s no surprise that the most impressive features in Dreamweaver CS6 make it easier to create adaptive designs that look great on small and large screens.

In this 2-hour training video, award-winning author and video host, Janine Warner, introduces you to Dreamweaver’s new fluid grid layout features and shows you how to create one, well-crafted HTML file and then use three sets of CSS styles to adapt how that page displays on mobile phones, tablets, and desktop computers.

AVAILABLE AT PhotoshopCAFE.com
save 10% with code: SUPERGUIDE
There are some big feature inclusions in the latest iteration of Adobe's Photoshop Lightroom 4.

We are looking at a new Process Version. Dubbed PV2012. The main change is dropping of the Brightness, Recovery and Fill Light sliders.

The sliders have largely been replaced with Shadow, Highlight, Whites and Blacks. These are more consistent with what we are used to working with in Photoshop. Shadow Highlight replace Recovery and fill light with some changes to try and eliminate halos in images that are heavenly processed. The Whites and Black set the white and black points in the histogram, much like what you would expect from the white and black slider in Photoshop levels. Having used these for a while, I'm a big fan of the new Process Version.

Using these sliders is very intuitive (Did you ever know the difference between exposure and brightness anyway? - I know there is a difference, but it was a point-making rhetorical question). PV 2012 produces good results without much effort. See the image I quickly ran through it. The bad news? Some of your previous presets will need to be upgraded to properly work with Lightroom 4.

But wait. It gets really cool about here. More options have been added to local corrections (Adjustment Brush and Graduated Filter) these include White Balance, moire, noise, shadows and Highlights. Wait, did I just say Moire? There is now a moire reduction filter, which works really well. Having used the Sony NEX and Lumix GF series of Micro 4/3 cameras, I have noticed moire patterns sneaking into some photographs. While this dithering effect might be a nice novelty for a second, I have a feeling the moire reduction will be a popular feature.

MAP MODULE AND GEO-TAGGING

Lightroom 4 taps into Google Maps and allows you to geo-tag your photographs. (Internet connection required). The photographs can appear on the map exactly where they were shot. If you are using an iPhone or other camera that has built in GPS, then the photographs are automatically added to the location that each photograph was captured. You can zoom in
images onto the maps, their metadata is populated with location data including GPS coordinates and city and street names.

When you click on a pin, you will see a thumbnail pop up. Click the arrows to cycle through each photograph that is tagged in the corresponding location.

Once a photograph is tagged, a badge will display to indicate that tagging has been added. Click the badge or double click the photograph thumbnail to go to the location on the map.

You can type a location into the search bar at the top right of the screen. Doing this will cause the map to display that exact location. You can now drop the photos onto the map and have them added to the tags.

The filter bar at the top of the module also allows you to sort the Photos in the filmstrip based on location.

If you don’t have a GPS enabled camera, you can manually drop the photos from the filmstrip directly to the map to create pins. New, since the public beta is the inclusion of reverse Geo-Tagging, as you drop your photographs snaking up the road of MT. Haleakala in Maui.

If you have a tracklog file for a handheld device or App. (such as geotagphotos), you can import the file into Lightroom 4.

Here is a tip for you: After you have spent a great deal of time zooming in and out, you will wish (as I did) for a way to make a

and out of the map using the slider or mouse wheel. It’s actually very accurate as you can see my photographs snaking up the road of MT. Haleakala in Maui.
marquee selection. (Click and drag to zoom). I accidentally discovered if I hold down the alt/option key and drag around an area of the map, Lightroom will zoom to that location.

VIDEO

Unless you have been living on a desert island, or you have your head buried in the sand, you will know that video is very popular with DSLRs and Micro 4/3 cameras. I’m not going to get into all the reasons, uses and benefits of video here because we fully embrace it and have quite a few training titles on video for photographers already.

Lightroom 3 brought us the ability to add video to the Lightroom catalog and a crude way to preview them. Previews where made though Quick time, by popping the video up as a separate video file. Thankfully all that has changed. Lightroom 4 provides the ability to preview video directly in the application. (You can also create stacks from your video files). Naturally H.264 Mov files such as those captured by Canon 5D Mk2, 7D etc are supported. A surprising move is the addition of AVCHD support (The standard format for many consumer and micro 4/3 cameras.). The move isn’t surprising because of it’s practical use, it’s because AVCHD is a very complex CODEC and difficult to support. Kudos to Adobe for adding this functionality.

Not only can you preview your video files, you can also trim the clips by setting an in and out point. (Trimming away the beginning and the end of the clip for non-video peeps.) Click the little circle looking thing to open the timeline.

Ok, here is where it gets VERY exciting. You can apply many of the Quick Develop settings directly to the video. But wait, it gets better. You can apply a preset to the video.

The best way to make a custom adjustment to a video clip is to take a snapshot by capturing a frame.
Load the image into the develop module. Make the desired adjustments and sync the settings or save as a preset. Apply the preset to the entire video clip.

You can export your final video as H.264 (Standard for most things) or publish it directly to Facebook, etc.

**BOOK MODULE**

The book module is a place where you can layout your photographs into pre-made templates. You can place them one photo per page, or multiple photos per page. Each page can have its own template. You can’t make custom templates, but there is plenty to choose from and they are quite well designed.

Once you have selected the photos to add, there is an auto Layout button that will populate all the pages when pressed. You may also drag them into the layout individually. Some templates allow for blocks of text if you want to add written content along with the photos.

You can easily add page captions or photo captions, which can be positioned on any page. The text tools are quite robust with all the expected goodies such as font, style, color, alignment, leading and tracking etc.

Once you have finished creating your book, you have a couple of output options. Try sending the book to a service called blurb which will print either a hard or soft cover book and mail it to you. The estimated costs are even displayed in Lightroom as you add and subtract pages. The second option is to output to PDF. You could either print yourself, send to a print service of your choice, or distribute the book as an online PDF.
A nice feature is the ability to add a background. These backgrounds style up the pages nicely (as long as you don’t get too carried away).

**SOFT PROOF**

Something that has been missing in Lightroom is soft proofing. This is the ability to simulate different types of printers and media, by loading in their profiles and then accurately displaying them on screen. In the develop Module, click Soft proofing at the bottom.

You can now click in the side panel and load your printer’s profiles. Choose the options you want and then make adjustments to your photo for good printing results. As soon as you begin to work, Lightroom will create a virtual copy, so that your original isn’t changed.

**OTHER STUFF?**

Lossy DNG: Adobe has decided to introduce a new version of DNG (Digital Negative) called Lossy DNG. It’s quite brilliant actually. You can write out a RAW file with a lossy compression (like jpg). This reduces the file size to about 1/4 original size. The real advantages though, are the ability to change the image dimensions and add compression without losing the flexibility of the RAW format. Be careful though, because these files aren’t backward compatible with Lightroom 3. So you won’t want to go crazy converting all your files just yet ;)

You can now export photos directly to email. This is nice because it let’s you do it all from within Lightroom and doesn’t create a footprint of temporary images all over the place.

You will also notice some nice little pop up tips and highlights as you are working your way through the modules.

While reorganizing, you can drag a folder from one drive to another to relocate files. You can now select and drag multiple folders at the same time.

You can now create stacks within Collections.

You can hide and show modules by right clicking at the top of the screen and selecting the ones you want to show/Hide.

**HDR AND LIGHTROOM AND CAMERA RAW**

A new development in the latest release of Lightroom, 4.2 is the ability to work with 32 bit images. This is wonderful because you can use the adjustment brush to fine tune areas of the photograph while...
working in a 32 bit enviroment. The image below (and the cover image of this publication) shows the result of working with the adjustment brush in Lightroom. Notice how I was able to craft the image. (The same is possible with ACR).

In order to work with a 32 bit file in Lightroom, you must do the following.

1. Merge to HDR as mentioned earlier in this tutorial.
2. Save as 32 bit file, be careful to save as a TIF, it will only work with a Tiff.
3. Import back into Lightroom, or open in Adobe Camera Raw.
4. Use the adjustments as you would normally, but enjoy a lot more control and larger range of tones than before.

That’s all the breaking news on Lightroom. Don’t forget to check out our Lightroom learning microsite for up to date information as well as some free videos and presets. PhotoshopCAFE.com/Lightroom.

ABOUT THE AUTHOR

Colin Smith is founder of PhotoshopCAFE.com, which boasts over 20 million visitors. He is the author of the hit video, “Lightroom 4 for Digital Photographers” from PhotoshopCAFE.com
Here’s What We Love about InDesign CS6
Written By: Anne-Marie Concepcion, David Blatner, Bob Levine, Keith Gilbert, James Fritz, Mike Rankin and Steve Werner

Time stoppeth for no man… or InDesign user, apparently, as Adobe today rolls out their announcement of InDesign CS6. Everyone knew CS6 was coming (Adobe said it would be released the first half of this year), and we at InDesign-Secrets have all been using beta versions for a while — but until today we haven’t been able to discuss the features publicly. Now, let the floodgates open!

There are many features in InDesign CS6 to get excited about: the phenomenal ability create PDF form fields; the almost magical way you can set up objects on your page to move around when the page size changes; the option to export grayscale PDF files. There are also features that will make you scratch your head until you get used to them. For example, the Content Conveyor tools require some work to understand, but we’re convinced that some users will find this one of the most valuable features in the program.

All in all, there are dozens of new features in CS6. Until it is officially released we can’t really “review” the program as a whole, but what we can do is give you a good overview of what to expect and what you’ll want to pay attention to when CS6 shows up on your doorstep.

By the way, one of the biggest changes in CS6 is the availability of the Adobe Creative Cloud, which among other things, allows you to get access to all Adobe Creative Suite applications for a relatively modest monthly fee. We’ll be covering that in more detail in a later post.

**CREATING INTERACTIVE FORMS**

PDF forms fields (checkboxes, text entry fields, and so on) have been a long requested feature and have finally been added to InDesign CS6. The easiest way to try out the new form fields is to switch to the Interactive for PDF workspace. While you are in this workspace, there is a new library panel available under the window menu called “Sample Buttons and Forms”.

After dragging out these sample form fields into your layout you can edit them with the Buttons and Forms panel (formerly the Button Panel). From here you can modify their attributes like their description, font size, read only and more. If you prefer to create form fields from scratch you can convert any InDesign object into a text field, check box, combo box, radio button, or signature field. If you would like to test your form you will need to export your layout to an interactive PDF since the preview panel has been renamed to the more accurate SWF preview panel.

One could argue that PDF Forms are in CS6 mainly due to Tony Harmer’s ignite session at last years PepCon where he beautifully crafted a poem pleasing with Adobe to add
should react (move or resize) when you change the page dimensions. You test these rules by temporarily tugging on the page edges with the Page tool. Once you have the rules established, then you either permanently change the page size with the Page tool and the Control bar, or create an Alternate Layout with a new page size, telling InDesign to apply your liquid layout rules as the alternate layout is created. — KG

**LINKED CONTENT**

Liquid Layout is intended to help reduce the amount of work it takes to reformat pages, or portions of pages, for different sizes and aspect ratios. (See this post for a sneak peak Adobe presented last October.) It’s ideal for quickly adapting layouts between multiple sizes of tablet screens, or creating a series of ads at different sizes, or even for reformatting a book into a different trim size. There is some configuration and setup involved, so it is particularly beneficial for template-driven, repetitive workflows.

To use liquid layout, you apply one of five different “rules” to page items that specify how these objects should react (move or resize) when you change the page dimensions. You test these rules by temporarily tugging on the page edges with the Page tool. Once you have the rules established, then you either permanently change the page size with the Page tool and the Control bar, or create an Alternate Layout with a new page size, telling InDesign to apply your liquid layout rules as the alternate layout is created. — KG
CONTENT COLLECTOR/CONTENT PLACER TOOLS

Continuing with the theme of making it easier to reuse content, the new Content Collector and Content Placer tools aim to make it easier to quickly copy content between page, alternate layouts, or documents. When you choose either of these tools, a new interface element called the Content Conveyor appears on the screen. At its simplest, these tools and the conveyor behave like copy and paste, but you get an unlimited number of “clipboards”. In other words, you can “collect” a dozen different objects from one location, and then “place” them one by one in another location. The way that the tools and the conveyor work together makes it very quick and efficient to collect and place lots of different page objects. — KG

ON-OBJECT LINK STATUS AND CONTROL

Since linked content is a lot more important in CS6, the application gives you a more obvious way to tell when a story or an object is out-of-date. By default, a linked story or object shows an on-object Link Badge. (If you don’t want to see it, turn it off in View > Extras > Show/Hide Link Badge.)

PRIMARY TEXT FRAME

You can designate a text frame on the master page as the Primary Text Frame. (This replaces the Master Text Frame from earlier versions which never really worked the way you wanted to.) When you apply a different master page to your layout page, the story in the Primary Text Frame flows into the Primary Text Frame, following its shape and location from the new master page. And you no longer need to override a Primary Text Frame before adding text. This will eliminate a constant source of confusion for newcomers. —Steve

TEXT FRAMES THAT AUTO-SIZE

The end to text frame oversets? Debuting as a new tab in the Text Frame Options dialog box, the Auto-Size controls lets you set a text frame to automatically resize itself based on the amount of text it has, dynamically moving frame edges to fit as you edit the contents. You can specify that the auto-sizing is restricted to Height Only, Width Only, or both; choose which side(s) are allowed to move and which should stay locked down, and set a minimum height and width. Auto-Size settings can be included in an Object Style, too. Think of all those sidebars, captions, and pull-quotes that you never have to worry about over-setting or manually closing up empty space as you edit the text! Very easy to get spoiled by this one. —AMC
FLEXIBLE COLUMNS

It’s a fact that long lines of text are more difficult to read than shorter ones. This is most evident in newspapers. While InDesign has long had the ability to set number of columns and the widths of those columns in a text frame, changing those attributes meant manually opening the Text Frame Options dialog box and setting those numbers.

Wouldn’t it be great if, as you changed the size of the frame, the widths of the columns adjusted? Now they can. Just set the default width for a column and should you need to adjust the width of the frame the column widths will adjust accordingly. This ties in nicely to alternate and liquid layouts where you could have a portrait and landscape orientation in one file. — Bob

In previous versions of ACR if you were to significantly darken the highlight information and bring up the shadow detail you could get significant artifacting at that transition between highlights and shadows, as in the fringing of the trees around the motorcycle seat. In the current ACR 7, there is no such artifacting and the detail throughout the image is crisper and cleaner than I would have ever imagined from a single shot!

IMPROVED EPUB 2 EXPORT, NEW EPUB 3 EXPORT

A new dropdown menu in the EPUB Export Options dialog box gives you a choice of export formats: EPUB 2.01, EPUB 3, and an enticingly-named “EPUB 3 with Layout.”

First let’s get that EPUB 3.0 with Layout one out of the way: As with a few other new commands in InDesign CS6, this option is more of a promise than a working feature. Choosing it results in a warning that it’s an “experimental” format they’re working on, aimed toward “adaptation of layouts across different mobile devices,” (so the “layout” in the name does not mean a fixed-layout EPUB), and currently only “specific Adobe viewer technologies” will work with this format, but these viewers are not named and aren’t available (yet). In other words, move on, nothing to see here folks, but we’ll let you know.

New features in EPUB 2.01 (and EPUB 3.0) are more gratifying. First, there’s the existence of the EPUB 3.0 option itself. When you choose it, you’re able to do EPUB 3-only things like create an EPUB with vertical Japanese text and placed HTML and Adobe Edge animations (which use HTML5 and CSS3), and include links to one or more external Javascript files. Exporting a document to EPUB 3.0 results in a valid EPUB 3.0 eBook, including the requisite new TOC.xhtml file and a fall-back TOC.ncx file for EPUB 2.x reading engines. Now all we need is an EPUB reader or device that understands EPUB 3, and we’re all set.
Adobe has added new features and improved the mark-up for EPUB projects in general. You now have much more flexibility when splitting a layout into multiple XHTML files in the EPUB because you can tag one or more paragraph styles to Split Document whenever you export it to EPUB. Tables retain their cell styles (they get converted to CSS) along with column width and minimum row height information. Anchored and inline text frames now retain settings like fill color, border style and width, padding (text insets) and margins for text wrap. You can link to multiple custom CSS files instead of just one. —AMC

**GRAYSCALE PREVIEW AND GRAYSCALE PDF EXPORT**
You can preview a color file in Grayscale on the screen, and then export to a grayscale PDF right from InDesign. It’s pretty simple, but it’s something that many users have been asking for a decade. — KG

**ALIGN TO KEY OBJECT**
This control, which has previously only been in Illustrator, now makes its debut in InDesign. It allows you to choose which object in your selection you want your other objects to align with. To tell InDesign which object in a multiple selection is the key object, just click it. Its selection border gets an extra hit of pixels, making it easy to spot in a crowd. — KG

**THE LITTLE THINGS**
User Interface tweaks: INDESIGN HAS STOPPED YELLING AT US ALL BY DEFAULT. Whew! Panel names and workspaces are now displayed in Title Case instead of ALLCAPS. Also, there are more subtle tweaks: You can collapse panels back into the dock by clicking on their names, just like we used to do in CS4. Also, panels have a gripper bar at the bottom for resizing, close buttons are now xs instead of circles, and anchored object controls now match the layer of the frame they’re attached to. —Mike

Placeholder text language options: When you select the Type > Fill with Placeholder Text, hold Command/Ctrl to select from a list of nine languages for the placeholder text, including Roman, Greek, Hebrew, Arabic, Japanese, Korean, and Chinese. But sadly, no bacon ipsum, Elvish, or Klingon yet. —Mike

Split Window: The Split Window icon, located in the far bottom right of each document window does one simple thing—it splits the window into two separate views. This provides a quick, straightforward way to see two different views of your layout at once. You can zoom in on the page in one view, and see the entire page in the other view. Or, you can work on a master page in one view and see page six in the second view. Or, view your horizontal-orientation tablet layout in one view, and the vertical-orientation alternate layout in the other view. — KG

Complex Calculations in Dialog Boxes and Panels: You can now enter something like 45/6*79 and InDesign will calculate the correct answer. –Mike

Digital Publishing workspace: The “Interactive” workspace has been updated to “Digital Publishing,” which includes the Liquid Layout panel and the DPS

---

Click to close
Folio Builder panel. You will still need to download the latest DPS tools separately; once you do, then this workspace will also contain the Folio Producer panel. –Mike

Export to PNG (with transparency): You can export a selection, a page range, or a document to PNG. –Mike

Extension Manager Sets: You can create and manage sets of extensions through the CS6 Extension Manager just like the old feature of plug-in sets. —Mike

Hunspell Dictionary default: For most languages, the Hunspell open source dictionaries are now the default dictionaries for spelling and hyphenation. These are the same dictionaries used by Mac OS X, OpenOffice, and browsers like Chrome and Firefox. —Mike

Accurate screen sizing: Break out your old pica rulers and hold them up to the screen. InDesign CS6 does a much better job of matching on screen sizes to real life. —Mike

Keeps with Spans and Splits: Simply put, the keeps functions for paragraphs (Keep with Next, Keep lines together, etc.) now work on paragraphs that are set to span columns or split. Even though we’re classifying it under “little things,” we’ve been informed that getting this to work was actually quite the programming challenge, involving hundreds of hours. Huzzahs to the software engineers! —Mike

Recent Fonts List: You can now display a list of up to 50 recently-used fonts in the Control, Character, and Glyphs panels, and at the top of the installed fonts list in the Type > Font menu. —Mike

Save as IDML: While the process of downsaving via IDML hasn’t changed, the folks at Adobe have tried to take some of the mystery out of process by adding IDML to the options in the Save As dialog box, and including a message about how the downsaving process works. —Mike

PANTONE PLUS SERIES color swatch libraries: The PANTONE libraries included with InDesign have been updated with the new PANTONE PLUS SERIES colors. –KG

Name Ranges in XLSX files: A bug prevented named ranges in Excel 2007 and later from displaying in the place dialog. The only way to place named ranges was to save it back to XLS. This bug has been fixed in CS6. —Bob

Export to Interactive As Pages: InDesign CS5 and 5.5 insisted that when you choose File > Export > PDF (Interactive), you would always export spreads. You can now choose between exporting pages or spreads. The default is spreads. —Steve

Package files includes overlay assets: With CS5 and CS5.5 anything used only in an overlay such as an HTML page or an audio controller image was ignored in the package process. CS6 creates an Overlay Assets folder for these objects. —Bob

FOR MORE INFORMATION
Of course, this short article only scratches the surface of each of these features. If you want to go deeper, check out:

Issue 47 of InDesign Magazine. This not only has a great roundup of CS6 features by Mike Rankin, but also includes great In Depth features about Alternate Layouts and Liquid Layout by Claudia McCue and Pariah Burke. Subscribers will get this issue immediately; it sometimes takes a handful of days to get it available for non-subscribers.

Adobe TV has a ton of movies ready to play on all the CS6 products. [Sorry, public link to come ASAP.]

And, of course, we’ll be covering CS6 for months to come at InDesignSecrets. Be sure to check back periodically for the newest info. Of course, we won’t forget about users of CS5 and earlier… we know that not everyone can upgrade right away.

ABOUT THE AUTHORS
Anne-Marie Concepcion, David Blatner, Bob Levine, Keith Gilbert, James Fritz, Mike Rankin and Steve Werner
Adobe has addressed many user requests in the release of After Effects CS6 and provided several powerful features to help motion graphics designers and filmmakers produce better content without needing to rely on a lot of third-party plug-ins or apps. The totally revamped 3D environment now includes bendable footage and comps and extrusions for text and vector shapes - all integrated into an interactive raytracing environment where the various 3D layers truly interact with each other. Adjustable mask feathering, Rolling Shutter repair for DSLR footage and an amazing 3D Camera tracker have also been added to the mix. Built on top of major performance enhancements and caching features, makes After Effects CS6 a must-have update.

ROLLING SHUTTER REPAIR

One of the most problematic issues with DSLR footage is the rolling shutter or “jello effect” caused by rapid panning against vertical lines in your scene - such as the edges of buildings, windows, buses, poles, trees, etc. Adobe has included the Rolling Shutter Repair effect to After Effects CS6 (also included in Premiere Pro CS6 as well). While the effect is applied directly to the footage layer, it can reduce the effect greatly but may require some additional tweaking and keyframing to control the amount of correction on certain footage.

Adding keyframes to the Rolling Shutter Repair effect on the Timeline can control the amount of correction exactly where you need it in your footage clip.

ADJUSTABLE MASK EDGE FEATHERING

The new Mask Feather Tool (located in the Pen Tool drop-down palette) in After Effects CS6 allows you to select specific points along the edge of your mask to adjust the amount and direction of the feathering you need. This eliminates the necessity to build multiple masks that have to be tracked or modified over time, and instead you can concentrate on one adjustable edge mask around objects you intend to roto. You can select existing Vertices’ along the path with the Mask Feather Tool and add an adjustment handle between the selected point to create a soft transition, or select several points to confine your adjustments to specific regions. And of course all of the Mask Feather Tool points are keyframable along the Timeline.
3D options such as Geometry and advanced Material capabilities. You can set the curvature (+/-100%) and the number of segments needed to provide a smooth curved plane. The Material Options now include Raytracing elements, such as Reflectivity, Metal/Plastic appearance, Specular highlights, Transparency and more. You can also set a solid layer to only reflect or accept lights/shadows, which truly expands the 3D capabilities in creating rich motion graphics.

**3D EXTRUDE & RAYTRACE**

Another boost in 3D performance in After Effects CS6 is the 3D Extrude option on text and vector shape layers. When you convert a text or shape layer to a 3D layer, your Geometry options are different that with sub-comps, footage, image and solid layers. You now have the ability to adjust the extrusion depth and bevel style and depth. Add to the fantastic new raytracing & materials capabilities and the ability to converge and interact with all other types of 3D layers that can reflect and cast shadows onto each other and there’s a world of creative options for you without ever leaving After Effects. While this isn’t intended to be a replacement for other more powerful 3D applications on the market (you can’t import 3D models or objects and...
can no longer import 3D layers from Photoshop) the new 3D capabilities in After Effects CS6 will help you create more dynamic motion graphics and titling.

Converting text and vector shape layers to 3D enables extrusion, beveling and raytracing features.

**CONVERT ILLUSTRATOR FILES TO SHAPE LAYERS & 3D**

You can now import AI files into After Effects CS6 and convert them to editable vector Shape layers. Which also means that when you convert the Shape layer to 3D you can extrude and bevel the layer. This is huge for motion graphics designers who often need to create a quick 3D version of a client’s logo or graphic designs to incorporate into their animations or titling. Of course all of the same 3D characteristics that apply to extruded text layers are also available for extruded Shape layers.

You can now import and convert AI (Illustrator) files to editable vector Shape layers and apply 3D extrusions just like text layers.

**3D CAMERA TRACKER**

The new 3D Camera Tracker in After Effects CS6 works differently than the regular point tracker or even planar trackers, as it looks at the pixels in a footage sequence and provides results based on how long objects and surfaces remain in the scene. The process is easy and semi-automated, when you simply apply the Tracker to your footage and allow it to analyze it. You then select either a triangulation of tracked points with the target by hovering over the processed scene with your cursor or select multiple points to align the target up with the plane you are trying to track to. Then simply right-click the target to create 3D camera and text, solid, null or shadow catcher and light layers. You can extrude your text and add additional lights to enhance your scene as appropriate.
The 3d Camera Tracker will analyze and process 3D tracking data from the movement of your original footage.

**AFTER EFFECTS CS6 PERFORMANCE ENHANCEMENTS**

Adobe has given After Effects CS6 one of the biggest boosts in performance in years. With the addition of “Hash Cashing” (and global caching), which allows you to create a RAM preview, make changes and if you undo or change your settings back, it will reserve your previous RAM preview from the cache. It also reserves them when you save your project or make layers visible or hide and return. This really helps speed up production when you have to continue to re-render your RAM previews to just compare a before/after or experiment with effects settings. And if you add an SSD drive to your machine (even a USB 2 or FW drive), you can assign that as your cache source and free up your computer’s hard drive and not fill it up with caching processes.

**ABOUT THE AUTHOR**

Jeff Foster is a published author of several computer technology, animation and video production VFX books and videos. He has been an Adobe Certified Expert and has served as an instructor and featured speaker at conferences such as Photoshop World, Macworld, Adobe MAX and the NAB (National Association of Broadcasters) Conferences. Foster has been producing and providing training for traditional and digital images, photography, illustration, motion graphics and special effects for DV and Film for over 20 years. Some of his clients include: Tribune Broadcasting, Motorola, McDonnell Douglas, Nestlé, FOX Television, Spike TV, Discovery/TLC, Deluxe Digital, Universal Studios, Lions Gate Films and Disney. You can learn more on his blog at http://PixelPainter.com. Check out his training on PhotoshopCAFE.
In 2011 Adobe Systems Inc. acquired a German company called “IRIDAS”, that had developed some very innovative technology and a fantastic color grading application called, “SpeedGrade”. We, at Adobe, were looking to round out Adobe Production Premium as a full end to end solution and SpeedGrade was a perfect fit. High-end colorists around the world were already using SpeedGrade and it made great use of GPU acceleration; which was already a key element to our production tools like Premiere Pro. SpeedGrade gets its name from the fact that it’s fast! With just a single GPU and an off the shelf PC, SpeedGrade is comparable in speed to other solutions using 4 GPUs and multiple workstations. SpeedGrade also works with many native RAW formats including RED R3D, Phantom RAW, ARRIRAW and SI-2K RAW and that means it’s easy to take advantage to all the deep color information in these formats.

The first thing you’ll see when you launch SpeedGrade is the Desktop, which is the main interface for loading your assets including image sequences, EDLs, QuickTime movies, OpenEXR files etc.

When working with hundreds of thousands of image sequences, the Desktop gives you easy ways to filter out what you don’t need and load just what you want.

It can also delve into child folders (Sequences + subtree) so you can just point to a parent folder and see all the individual image sequences nested within. You can also load audio files and stills shot for calibration like a MacBeth chart and put them on a new timeline or load an EDL and conform all the reels with one click! The large, scalable thumbnails make your assets easy to spot and each one includes a small scrubbable timeline at the top so you can zip through to find what you need. You can close and open the Desktop anytime by pressing the D-key.

Once you load your assets, you’re ready to work in the Timeline. The Timeline is where the action occurs; it’s where you can add grading layers, pan & scan layers and more. Most times you’ll be loading a linear timeline of clips from your NLE and Premiere Pro CS6 now has the ability to send a timeline of 10-bit DPX files directly to SpeedGrade. Once you close the Desktop you’ll be able to see the Monitor, which displays your clips from the Timeline.

There are controls on the right side to scale the image to fit your monitor but most people will be using SpeedGrade with a second calibrated display such as an SDI output from an NVIDIA Quadro card. SpeedGrade will work on any Mac or Windows computer with a GPU but having a dedicated workstation with a more powerful GPU will dramatically increase
The engineers of SpeedGrade did not stand still since the acquisition from Adobe, in fact they completely redesigned how grades are applied and they’ve chosen a layer-based metaphor which is not only dead simple, it’s an interface that every Adobe user already understands and uses every day. So to adjust any color, just add a new Primary layer and tweak away! You have unlimited control of applying more changes to that Primary or add another if you’re big into housekeeping. At any time you can save the changes as a .Look file that has the added benefit of being compatible with both Photoshop CS6 and After Effects CS6 (Note: Photoshop and After Effects don’t read masks or any geometry settings saved in the .Look file).

Beside the layers panel is the grading panel and it’s pure genius. One bugaboo that needs to be taken down is the idea that color grading must be complex or it’s not valuable. I completely disagree with this and I challenge that grading is being democratized and put into the hands of uses who’ve never been on the “dial turning” part of the business. It’s common to have a DP create a look on set and have a colorist match that later but SpeedGrade is fast becoming a tool that is used on set during production to not only create a look but have that look applied to a preview monitor so by the time the colorist is loading the files, they already have the look the DP designed. There are a great many users that want the control that has been previously hidden away in high-priced studios for their projects. Some of these same users have tried prepackaged software solutions for standard movie looks but you run the risk of looking like everyone else. SpeedGrade gives you the best of both worlds with simple to apply non-destructive looks but also the ability to edit those looks and create a completely unique final project.

SpeedGrade supports hardware devices like the Tangent CP 200 panels and the Tangent Wave or even a simple trackball or scroll-wheel mouse. All you have to do is right-click on any wheel with a standard mouse and SpeedGrade emulates a virtual trackball; moving the mouse changes the inside part of the color wheel (for changes in chrominance) and the scroll-

your productivity. There are also controls to hide or show each RGB channel, luminosity, cropping, overlays and aspect ratio correction.

**MAKING SELECTIONS**

The Timeline uses 4 modes of operation (All, In/Out, Master and Playheads). Each is suited to a specific need like automatically centering a clip or being able to zoom out and in to a traditional timeline view.

Below the Timeline are various tabs for working with the whole timeline or individual clips. The Timeline tab has controls for setting the FPS, stereoscopic 3D, calibration, saving timelines (as IRCP files) and EDLs and also the ability to drag a grading layer onto the Timeline. What I find very liberating is that everything is open, there are no fixed order of operations and SpeedGrade doesn’t “beep” at you and tell you can’t do something, you have complete freedom to add grading to a clip or on a series of separate layers and it will even extract the grading from a clip to a new layer. The scene change detection allows you to intelligently analyze a single clip and break it apart to individual clips and have each clip automatically get assigned its own grading layer. The Clip tab allows you to set several parameters for mirror and aspect ratio, but what’s truly magical is the Color Space tab and its ability to recognize a MacBeth chart and apply cubical auto-correction to neutralize any casts which is perfect for calibrating the input from more than one camera.

The Look tab is where I completely fell in love though; it’s a perfect blend of unfettered creativity and simplicity.

The Look tab is where I completely fell in love though; it’s a perfect blend of unfettered creativity and simplicity.
wheel, which emulates the outside ring on dedicated hardware, controls the outside of the colorwheel (for changes in luminosity). There are three wheels, one for Offset (also called Power or Slope) for controlling the blacks, one for Gamma (also called Knee) for adding or reducing light, and one for Gain which is white control. Above that are sliders for Saturation, Pivot, Contrast, Temperature and Magenta. Because some solutions change saturation before the grade and some after, SpeedGrade offers both for compatibility. Pivot shapes the curve for contrast so lowering the pivot produces a rather flat increase on contrast whereas a higher value produces a lower mid point for contrast, resulting in a crisper image. Contrast is just what it says and it may seem sacrilegious to colorists to have such a simple control to produce a change normally done using several controls but why have complexity when we don’t need it? Temperature can be used to quickly and easily warm or cool a part of an image but it can also be used to balance the red against the blue channel and the Magenta slider can be used to balance the green against the red and blue.

Now that may seem like quite a bit of controls but that’s only the beginning; every one of the controls I just mentioned can also be applied just to shadows, midtones and highlights! So instead of learning numerous controls you just learn one set and apply them to the part of the image you need to work on. Now if you’re paying attention, your first question would be, “What designates a shadow from a midtone, and a midtone from a highlight?” and you’d be perfectly correct in asking that question and SpeedGrade would answer you back by giving you individual sliders for each shadow, midtone, highlight.

So as you add a coolness to the shadows, you can also limit how far that coolness seeps into the mids. A convenient pop-up menu gives you an overlay in Color/Gray, Color/Black or White/Black so you can see exactly where each designation ends and begins. SpeedGrade makes is so simple to create a tri-tone look with different tints on each of the shadow, midtones and highlights. All the while you could be saving each stage of your creation to .Look files and call them up later for comparison. Looks can also be exported in many industry standard formats like Clipster LUT, 3DL, FilmLight Truelight LUT, etc.

LUTs can be designated as 8X8X8 up to 64X64X64

SpeedGrade gives you lots of control over secondaries including the ability to add as many secondary layers as you need. There are built-in primary colors for creating a key or + and – eyedroppers to sample colors in an image. You can fine-tune your selection using dedicated Hue, Lightness and Saturation slides; each with it’s own range and falloff.
Add to that the ability control Denoise and Blur and you can easily create a key for skin tone or any other colors you want to isolate. Secondaries are also saved in .Look files used within SpeedGrade.

Add to that the ability control Denoise and Blur and you can easily create a key for skin tone or any other colors you want to isolate. Secondaries are also saved in .Look files used within SpeedGrade.

The next layer that can be added is a custom layer that includes styles and effects like Bleach Bypass, fxBloom, fxDay2Nite and Gaussian Blur, etc..

What makes SpeedGrade unique in this department is that each of these custom layers comes with an independent opacity slider, just like Photoshop! This is perfect when you want a Bleach Bypass look but it’s too intense, just adjust the slider and reduce the effect. The colorists who we’ve shown this to in Beta versions of SpeedGrade really flipped out and loved it. It’s a real game changer in terms of control with zero compromises. Imagine using a LUT on its own layer with opacity as a creative tool – it’s incredible!

SpeedGrade also has the ability to add preset or custom drawn masks with individual node control and keyframing and the built-in planar tracker means you can have your mask follow a specific face in a scene for example. That alone would be great but again, German engineers have a way of looking at something old and making it new. I’m talking about the Mask Widget; a brilliant little on-screen controller to resize, reshape, feather and position any mask or node intuitively.

The design of the Widget allows a user to get instant predictable results with zero training – it’s just a brilliant piece of innovation that I wish I had in other Adobe applications. This same Widget is also used for positioning and scaling frames on a Pan & Scan layer.

Stereo3D workflows are also something SpeedGrade can handle including intelligent matching on left eye, right eye for parallax, rotation, vertical offset, relative positioning and color. You can preview your results to an external 3D display or use anaglyph on a computer display. Controlling the color in a stereo 3D image is just as easy as working on a 2D image in that SpeedGrade applies all changes to both eyes at the same time.

Output from SpeedGrade is set in the Output tab with the ability to render to any installed codec in compressed or uncompressed formats. Output can have burn-in and calibration applied if needed too. Some notable image sequence formats are 16-bit and 32-bit TIFF and OpenEXR, which are important for high end work. SpeedGrade is the perfect compliment to Adobe Production Premium.

ABOUT THE AUTHOR
Colin Smith (2), not to be confused with Colin Smith from PSC
Colin Smith has been swimming in the deep end of the video and imaging industries for over 20+ years. 15 of those years have been spent at Adobe Systems where he continues to evangelize leading edge solutions to customers all over North America including Hollywood filmmakers, New York media giants and broadcast and animation houses in Canada.

Colin’s passionate and accessible speaking style makes him a major draw at a multitude of Adobe events and seminars as well as making regular appearances on his hit show “No Stupid Questions” on Adobe TV.

When not on the road, Colin spends his time fighting crime by teaching law enforcement agencies to leverage Photoshop and other Adobe technologies and writing and recording music for his band “Raven House Poets.” You can check them out on iTunes.
Out of the gate, you will notice the newly designed user interface. Things have been rearranged to give more importance to your footage. The interface chrome has been reduced and finessed to get it out of the way and free up space for more important things. The buttons are new and the panels are more customizable than before, giving you the freedom to set up things the way you like to work.

The way the windows are arranged are a little different too. Gone is the media browser on the left side. It’s now replaced by nice large thumbnails at the bottom of the screen. These show previews of your footage. You can hover scrub, which means, as you move your pointer over the thumbnails the footage will scrub through. You can even set and out trim points in the thumbnails. If you don’t like all this newness, you have the flexibility to choose the CS 5.5 layout.

Thought went into the layout, when you open an earlier project, it opens in the earlier workspace.

Keyboard shortcuts are also changed to more closely mimic the ones in final cut pro. Once again you can change them in the preferences if you so choose.

PERFORMANCE

All of this cosmetic enhancement would be called “all show and no go”, if something hadn’t happened in the performance area. What has been dubbed the mercury playback engine has received a turbo charge with native support for open CL and further GPU optimization. All this amounts to a much snappier and speedier response while working in premiere pro CS6. It now supports resolutions up to 5k. Also worth noting, playback now continues when adjustments are being made to filters.

AUDIO

Audio has received some attention, with the
addition of better and larger meters and also some love in the audio panel.

**3 WAY COLOR CORRECTOR**

The 3 way now acts the way you would expect it to. The way it works is now similar to Final Cut Pro.

**ADJUSTMENT LAYERS**

One of my personal favorite features is the addition of adjustment layers. These work just like the non-destructive adjustment layers in Photoshop. Through down an adjustment layer and all kinds of corrections such as color corrector, luma curves etc are all sitting on a layer which overlays all the footage. Ah, this is so nice and makes life so easy. No longer do you have to create a ton of presets and keep copying and pasting them.

**WARP STABILIZE**

One of my favorite features added in After Effects CS5.5 is the Warp Stabilize. This tool allows you to take shaky footage and smoothen out the movement. It analyzes the movement and either crops or uses content aware technology to fill in the edges. This can make a shaky movement almost look like it was shot on a dolly or tripod. Perfect for HDSLR footage. Why do I bring up an After Effects feature? Because it’s now built natively into Premiere Pro CS6. This makes it so quick and easy to stabilize shots without having to use dynamic link, or render out After Effects comps.

**MULTI CAM**

Multi camera editing has now been increased beyond 4 cameras and now supports as many cameras as your hardware can handle.

**ABOUT THE AUTHOR**

Colin Smith is founder of PhotoshopCAFE.com, which boasts over 30 million visitors. He is author of the book Video in Photoshop for Photographers and Designers. Colin has consulted such companies as Adobe Systems, Edison International, Apple and Disney Studios.

We hope you enjoyed this superguide. Please send your friends and coworkers to: PhotoshopCAFE.com/CSC to get their own copy for free.
http://www.photoshopcafe.com/members/